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With the exception of that which is running in
VirtualBox, my home is a “Windows­free” zone. As
much as I wish I didn’t have to run Windows in a
virtual machine, that is not reality.
Thanks to the shortsightedness of
many software vendors, I (like
many other Linux users) must
keep a copy of Windows around,
regardless of how much I
think/know that it stinks.

For example, most of the income
tax software to file your income
taxes runs only on Windows or
OS­X. Sure, there are some free,
web­based income tax software
tools around, but their abilities
often fall short of meeting the
needs of all but those users filing
the simplest of returns. As a
result, running a Windows income
tax filing software bundle is often
the only choice.

Why am I picking on income tax
filing software vendors?
September and October typically
are the months when those software vendors ramp
up their promotional e­mailings, with offers of
discounted prices to “early bird” purchasers.
Sometimes, their offers allow customers to buy or
reserve a copy of the software at last year’s prices,
before price hikes occur. So, as you might imagine,
my email inbox has seen a steady increase in
promotional emails from these companies.

What I cannot understand is why software vendors
would willingly limit their market to Windows users
only. It seems to me that it would (or should) be a
simple task to create software that is capable of

running on all platforms – and not just one that is
losing market share every year. Meanwhile, Linux’s
market share continues to grow year after year.

Some surveys estimate that
Linux’s market share is higher
now than OS­X’s market
share. You would think that
software vendors would jump
on being the first to tap into a
previously untapped market.

Perhaps when Windows
market share has dropped to a
hidden “critical level,” we’ll see
these software vendors
support cross platform
solutions. Java and Python
immediately come to mind as
cross platform solutions,
although the former has been
plagued by security issues for
what seems like forever. PHP
also seems like a viable
solution, allowing users to run
income tax software in their
favorite web browser.

So, I keep a copy of Windows around in VirtualBox,
ready to run the software for which there really isn’t
any alternative. I can remember six and seven years
ago, when I switched to using Linux. Back then, I
would only set up my Linux installations as a dual
boot with Windows XP. Unfamiliar with the Linux
landscape back then, I was afraid of not being able
to run my favorite Windows programs that I had
come to depend on. It was all I knew, and Linux (at
that time) was the unknown. What I failed to
consider or focus on was the tasks that I was
needing to do on the computer. Focusing on the

programs left me blinded to finding alternatives to
get those tasks completed.

Eventually, as I became more and more accustomed
to Linux, I found alternatives for every Windows
program I used to use – except for income tax filing
software. As time went on, I found myself booting
into Windows XP less and less, with months often
elapsing between Windows logins.

I eventually eliminated my dual boot installations,
and reclaimed the “wasted space” that was formerly
consumed by Windows. Instead, I migrated to
running Windows XP (and more recently Windows 7)
in VirtualBox. About the only thing that I regularly
use my Windows virtual machine installations for is –
if you can’t guess – running income tax filing
software. The bonus is that Windows now runs
better in VirtualBox than it ever did when it was a
bare metal installation.

It’s rare that I even boot into my VirtualBox copies of
Windows. Linux, and particularly PCLinuxOS, has
fully replaced Windows as my daily operating
system. For me, the only “holdout” is the income tax
filing software. Other users may have other
Windows­only programs that they cannot live
without, and that don’t have a suitable substitute for
under Linux.

Running PCLinuxOS, and then Windows in
VirtualBox, provides me a perfect solution. I get the
security and stability of PCLinuxOS for meeting all of
my other computing needs, and I still get to run
those few Windows­only programs when I need
them (although, that need has dwindled to only one
case).

Until next month, I bid you peace, happiness,
serenity and prosperity.

Welcome From The Chief Editor
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On October 24, 2003, PCLinuxOS Preview .4 was
released as a fork of Linux Mandrake (Mandriva) 9.2…

And so it began, 10 years ago this month. Since that
time, PCLinuxOS has matured into its own
independent Linux distribution. Just uttering the all­
still­too­common line that PCLinuxOS is still a fork of
Mandriva may cause sparks to fly. While PCLinuxOS
may have been originally forked from Mandriva, it
also borrows from openSUSE, Fedora, Ubuntu,
Knoppix, Mepis, Debian, Slackware, Arch and just
about any/every other Linux distro around.

What’s even more amazing is that PCLinuxOS
continues to thrive, without the backing of
multimillionaires and billionaires funneling cash into
its coffers, and without the backing of any
corporation. PCLinuxOS truly is a community Linux
distribution, with virtually all of the funds to keep it
going coming from donations of its users, either
monetarily or by the donation of services.

To commemorate the 10 years since the “birth” of
PCLinuxOS, below is a reprint of part of an article
we ran last December, as part of the Windows
Migration series of articles. I doubt that experienced
PCLinuxOS users ever tire of hearing this story.
Without a doubt, new PCLinuxOS users will want to
familiarize themselves with the tale of PCLinuxOS’s
origins.

What Is PCLinuxOS?

PCLinuxOS is a Linux distro, just like Ubuntu,
openSUSE, Fedora, Mepis, Knoppix, Debian,
Slackware, Arch and about 600 others. Probably the
best way to describe PCLinuxOS is to provide a brief
history from the founder of PCLinuxOS, Texstar –
a.k.a. Bill Reynolds (pictured below).

In the summer of 2003, I became interested in Live CD
technology after looking at Knoppix and a fresh
distribution from a fellow named Warren, called Mepis. I
was interested in helping Warren with Mepis at the time,
but I had no clue how to build DEB files. Coming from 5
years of packaging RPMS and not really wanting to learn
a new packaging system, I happened to come across a
South African fellow by the name of Jaco Greef. He was
developing a script called mklivecd and porting it to
Mandrake Linux. I, along with Buchanan Milne
(Mandrake contributor) and a few others, began working
with Jaco to help debug the scripts. I got an idea to make
a livecd based on Mandrake Linux 9.2, along with all my
customizations, just for fun. I had previously provided an
unofficial 3rd party repository for the users of Mandrake
for many years, but had since parted ways. Since
Mandrake was a trademarked name, myself and others
decided to name the Live CD after our news site and
forum, pclinuxonline, thus PCLinuxOS.

Preview .3 was my first attempt to make a livecd. I
distributed it initially to about 20 people to get their
reaction and feedback. Everyone who tested it loved the

livecd but there was one thing missing. There wasn't a
way to install the thing to the hard drive! srlinuxx from
tuxmachines.org came up with a novel way to copy the
livecd to the hard drive and posted it on our forums. Jaco
utilized this information and inspiration from the Mepis
installer and wrote a pyqt script to make the Live CD
installable, thus the birth of a new distribution.

On October 24, 2003, PCLinuxOS Preview .4 was
released as a fork of Linux Mandrake (Mandriva) 9.2
utilizing mklivecd scripts from Jaco Greef, a multimedia
kernel from Thomas Buckland (2.4.22­tmb) and a
customized KDE (3.1.4­tex). Preview .5 through .93 were
built upon on previous PCLinuxOS releases. After three
years of updating one release from the other using the
same gcc and glibc core library, we found too many
programs would no longer compile or work properly
against this aging code base.

In November 2006, we utilized a one time source code
snapshot from our friends at Mandriva to pull in an
updated glibc/gcc core and associated libraries. We spent
the following 6 months rebuilding, debugging,
customizing, patching and updating our new code base.
We pulled in stuff from our old code base, utilized
patches/code from Fedora, Gentoo and Debian just to
name a few. This is why you will never see me distro
bashing, as it would be hypocritical to do such a thing.
We are still dependent in many areas on other distros
development processes due to our limited but hard
working volunteer development team.

On May 20th, 2007, we felt we had reached a pretty stable
base and released PCLinuxOS 2007. It utilized our own
kernel from Oclient1, KDE built by MDE developer Ze,
updated mklivecd scripts from IKerekes & Ejtr, a heavily
patched Control Center, graphics from the PCLinuxOS
beautification team, and many application updates from
Thac and Neverstopdreaming. Development continues as
work is being done for a Minime release and an

Happy 10th Birthday, PCLinuxOS!
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international DVD. A future release of PCLinuxOS will
feature an updated kernel, KDE 4, fresh Xorg server and
all the latest applications. All in all it has been a great
ride and we have made many friends along the way. Some
have gone on to other distributions and many are still
here from our first release. As I've always said, we're just
enjoying Linux technology and sharing it with friends who
might like it too. We hope you have enjoyed the ride as
well.

While the above was written a few years ago,
PCLinuxOS has continued to thrive and evolve.
Shortly thereafter, MiniMe was released. MiniMe
represented a barebones KDE installation, with little
else than the bare desktop and core Linux OS files.
Designed for more advanced users, MiniMe allows
users to install only those applications that they
want. Even though this distro uses the “rolling
release” update method, new Live CDs were
released every year (and recently, even more often)
so a user wouldn’t have to download a huge number
of updates after installing to make sure they had the
most up­to­date system available.

In 2009, several developers left PCLinuxOS to start
their own distro. While this happens in many other
distros, PCLinuxOS hasn’t suffered from it, and is
still one of the top distros. In the wake of their
departure, others stepped up to fill the vacated
developer roles. Several other users stepped up to
create the various “flavors” of PCLinuxOS. Today,
there several “flavors” of PCLinuxOS available to
users, each presenting PCLinuxOS a choice of
which desktop environment to use.

To this day, the KDE desktop is still employed in the
“main” PCLinuxOS release. However, all of the other
desktop versions utilize the exact same Linux core,
as well as the same repositories.

Following the rolling release design, improvements
are always being made, and things evolve. First
Texstar, followed by the PCLinuxOS development
team, expanded their focus a bit, and a much­

wished­for 64­bit edition of PCLinuxOS has recently
been offered. Requiring a rebuild of all of the
applications in the repos, the 64­bit repo now has
over 8,700 of the 12,000+ applications in the
PCLinuxOS 32­bit repo.

Birthday Wishes From PCLinuxOS Users

I’ve invited some veteran PCLinuxOS users to
express their “birthday wishes” for PCLinuxOS’s
10th anniversary. The well wishes are presented in
the order in which I received them, via email. I’ll start
it off.

I’ve been a PCLinuxOS user since PCLinuxOS .93,
a.k.a. PCLinuxOS 2007. Prior to arriving to the
PCLinuxOS community, I was a brief (very brief –
only about six months) Ubuntu and Kubuntu user.
The unstable nature of those two pushed me to look
around for something that worked better on my then
aging hardware. After trying a few distros, I stumbled
across PCLinuxOS. Not only was all of my hardware
recognized and properly configured, but I found a
stability that had previously been lacking. As a
bonus, I also discovered a community that is second
to none.

Thank you, Texstar, and all of the other developers,
for creating the best Linux distro around. Happy 10th
anniversary, and I hope and pray that there are
many, many more years of PCLinuxOS. – Paul
Arnote (parnote), The PCLinuxOS Magazine
Chief Editor

I've been using Linux for only 3 years now and 2 of
them have been with PCLinuxOS. I'm happy I've
found this distro but at the same time regret for not
having the chance to do this earlier.

This little miracle has changed my computer life. I've
finally found peace of mind and I've been running
trouble­free all this time. I don't have to worry again
about viruses, trojans. updates that last forever and
mess up the system every time, formatting my hard
drive every now and then, long boot and loading
times, privacy and security issues, to name just a
few.

First of all, I want to say a big THANK YOU to all the
people responsible for PCLinuxOS. They're just a
small team with no funds or unlimited resources that
work hard to provide a rock­solid operating system
for all of us.

Second I want to wish PCLinuxOS a Happy Birthday
with all my heart. May it live for many more years
and provide us with all the greatness that can be
found nowhere else. PCLinuxOS, forever and ever!
– Antonis Komis (agmg)

Wowee PCLinuxOS you are now 10. =­O You are
getting quite grown up. :­)

Happy Birthday to our favourite (or favorite) OS. I
have been privileged to use PCLinuxOS since 2007.
A fellow Kiwi sent me a copy of 0.93 to try out. I
have been using it almost exclusively since. – Jim
Wilkinson (aka jimwilk), New Zealand

Happy 10th Birthday, PCLinuxOS!
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How does one give birthday greetings
And make it special in every way

How does one send birthday wishes
With something new and original to say

How does one express the best to Tex
And in a different style display

The special things about PCLinuxOS
That we love and use each day

I do not have the answer
No fresh verses to convey

So rewind my old birthday messages
And press the button that says REPLAY
– ms_meme

Bueno Paul, como se que me entiende le voy a
contestar en español.

Hace ya 10 años? Increíble!!!, parece el otro día
cuando empece mi relación de amor y enfado con
Pclos, al igual que con cualquier relación, existen
momentos buenos y momentos malos, pero
francamente han sido mas los momentos buenos
que los malos.

Yo me considero un "Pclos­user", así pues, espero
que PCLinuxOS, siga en mi vida como mínimo otros
10 años mas, eso si me gustaría que hubiera un
pequeño cambio con respecto al escritorio que uso.

Gracias Pclos, por sus 10 años de trabajo y ilusión,
en verdad y con el corazón en la mano les deseo
feliz cumpleaños y que cumplan muchos mas.

El mundo Linux, sin Pclos, no seria lo mismo, mil
gracias. – Agust (Pclos user desde 2005)

Bacon Apple Pie

Happy Birthday, PClinuxOS!

One of the "most fond memories" I have as a
member was the night we had "Zombies."

I forget what year it was, but I was logged on late at
night when they attacked. I was probably one of the
first to see them.

A lot of people got upset about that and the Zombies
have not been back but... a TOAST to the Zombie
attack. A stroke of genius if you ask me. – Rudge

I have been using PCLinuxOS since the release of
Preview .4. Thanks Texstar, with such limited
resources, a masterpiece has grown during the past
10 years. Here's to looking forward to many more
years of the best of PCLinuxOS! – David Moore
(YouCanToo), Oregon

Happy 10th Birthday, PCLinuxOS!

I have been using PCLinuxOS since 2006, starting
with release .92. I tried Ubuntu (because my brother
uses it), but I found I was much more comfortable
with PCLinuxOS, and it worked perfectly for me, so

I've been here ever since! I’ve found a wonderful
second family, and continue to be amazed at the
helpfulness of the forum members.

Thanks so much, Texstar, for making such a great
distro! – Pam, aka Meemaw, PCLinuxOS
Magazine Assistant Editor

I really don't remember the first time that I heard of
the Linux operating system. It was probably around
1993, whilst I was using MS­DOS 3 point something
or other and an early version of MS­Windows.

Then one day, I got hold of a set of installation disks
for Red Hat Linux and installed it. The experience
was not a good one. The installation took several
attempts, but eventually I had a Linux system
installed, and I set about exploring my new world.

Although I could see that the command line was far
superior to MS­DOS, the graphical interfaces
available at the time were disappointing, and not
really usable in a production environment. Network
support (actually all hardware support) was, at best,
very poor.

Microsoft Windows had Win3.1, and then Windows
98 graphical user interfaces, running on top of MS­
DOS, which were far superior – and usable.

But Linux was an operating system based on Unix,
the core OS since the early '70s and so it had
potential if it could be developed. My interest was
aroused and I kept returning, trying different
distributions, as they became known, and finding
them to be more and more usable but still missing
the mark for every day adoption.

That is until sometime around 2007, when I
stumbled upon a Linux distribution called
PCLinuxOS. A relatively new distribution with its
origins in Mandrake Linux (which I had found to be
very promising but…).

Happy 10th Birthday, PCLinuxOS!

http://elicooks.wordpress.com/2008/10/09/bacon-really-does-make-everything-better/
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I installed the system and almost everything worked.
The KDE desktop was (almost) as good as the MS
offerings. I was ready to move to Linux, and with
PCLinuxOS, which although still a relatively new
player on the field, I felt reassured and confident
with.

Using PCLinuxOS 64bit KDE today, I find it hard to
believe that this distribution is only now coming up to
its tenth anniversary. PCLinuxOS has matured and
developed, year on year, to be a real challenge to
some of the other, better funded, distributions that
stand at the head of lists, such as Distrowatch.

To PCLinuxOS, Texstar and the rest of the
developers, HAPPY BIRTHDAY PCLINUXOS!

I wonder what the next 10 years will bring.
– Peter Kelly, a.k.a. critter

Chocolate & Bacon Cake

I can remember the moment I hit on Linux and,
specifically, PCLinuxOS. It was the late 1990's. I was
running Windows 98. I don't know how it happened
or what I was doing, but my computer just went into
fits, starts and stops. The Blue Screen of Death had
reared its ugly head. I called Windows support and,

rather than charge me for the time and trouble of
fixing my system, they walked me through
troubleshooting and editing of the registry. This took
place each evening over a two week period. I always
scratched my head about not being charged. It
suddenly dawned on me that the problem was
probably widespread and M$ was keeping it quiet by
simply fixing it "under the table."

After that nightmare, I decided I had had enough. I
started looking around for Linux distros. I tried them
all. I liked Mandriva (at the time called Mandrake)
and settled in there. But the community support
wasn't as accessible as other distros. Well, this lead
me to search for distros forked from Mandriva. Distro
bouncing around for several months finally brought
me to PCLinuxOS. It was easy to download, easy to
install (One mouse click! Wow!), and the community
was right there to help. The PCLinuxOS community
didn't care if you were a programmer, web designer,
carpenter, plumber, homemaker, or like me, a
cartoonist. They wanted you to have the best Linux
experience with what they believed to be the best
Linux distro out there. And I believe PCLinuxOS to
the best, too!

And a really terrific thing happened. Encouraged by
the PCLinuxOS community, I was able to contribute
and give back in my own way. I found myself offering
help on the forums to minor issues that I had solved
(through the aid of others). I wrote articles and
submitted cartoons to this magazine. And I tried my
hand at the Konsole learning, little by little, its
commands and intricacies (I'm still learning this.)

All these years later, I now run PCLinuxOS on two
desktop PCs and a notebook computer. I also
installed PCLinuxOS on an older laptop and desktop
system for my brother Tom. (He loves it! No more
BSOD!)

So, Happy Birthday, PCLinuxOS! Thank you so
much for so many great years of stable, secure, rock
solid computing! Your stability has kept my
computers up and running and online, your

community has been a great teacher, and your
repository (with GIMP, Scribus, LibreOfffice, and
other top notch graphics tools) has allowed my
creativity to soar! – Mark Szorady, a.k.a
georgetoon

So… PCLinuxOS is ten years old? Congratulations,
folks, for making it happen for this long! A Linux
distribution doesn’t survive for long on air and empty
promises – it either delivers or it withers. PCLinuxOS
has consistently delivered, even through some of the
more tumultuous times in its recent history.

I first came to PCLinuxOS back when 2007 was
current, in March, I think. It took several months later
for me to get involved in the community, and, when I
did, I wanted to kick myself hard for not joining
sooner. The reason? PCLinuxOS is the vibrant,
multi­faceted jewel it is because of the efforts of its
people. No other distribution I’ve seen has a
community anything like this one. Developers,
packagers, folks compiling documentation, all the
folks on the forums sharing knowledge, and just
laughing and crying together. It feels like family.

One of the basic ethics of the distribution is echoed
in the slogan I first saw with PCLinuxOS 2007:
Radically Simple. It’s not about making things
complicated – it’s about making things that work “out
of the box” and are truly usable and useful. Even
now, after all these years, it still rings true. I’ve seen
some who turn this meme on its head and write it as
Simply Radical, and there’s a grain of truth in that
attitude, too. The community has a tendency to think
in edgy, innovative, and sometimes disruptive ways
that keep the distro fresh and keep it moving forward
with the times, and that’s a good thing.

Through all the changes that came with the
introduction of KDE4, newer kernels, and through all
the changes that keep happening in the Linux
community in general, PCLinuxOS has stood out as
a leader on the desktop. The community has
sometimes had periods where we disagreed on the

Happy 10th Birthday, PCLinuxOS!
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best way forward, and where many of us (including
me!) had to learn new ways of doing things as
desktop environments changed and became more
complex, but, at core, PCLinuxOS has survived,
evolved, and grown into the distribution it is today,
continually reflecting that basic ethic of radical
simplicity.

So… ten years on, it looks like PCLinuxOS is still
true to its founding principles, still one of the most
usable, powerful, stable, and useful operating
systems out there for desktop use. Happy Birthday,
PCLinuxOS, and here’s to many more!
– horusfalcon

Bacon & Corn Griddle Cakes

HAPPY BIRTHDAY PCLINUXOS !!!!

10 Years. A very long time. Well, in Earth years.

I wonder, Mr. Reynolds, if you had any idea what
your creation would become?

We of Antares intercepted your first version 10 years
ago, and we were impressed. I myself was made
aware in July of 2009. I have never looked back.

There are times I reflect back on what my life was
like Pre­P ( My description of Pre­PCLinuxOS ). Not
a pretty picture. Constant problems to even go
through a day not having some issue with Windows.

With “Now­P”, I just use my computer. I don’t worry
about anything. It has been ages since even the
smallest problem with “OUR” OS. Anything that has
gone wrong, was my fault. Hasn’t even been much
of that.

TEX you are a Giant among Giants.

I respect you. I thank you. All your hard work has
payed off.

10 Years. Yes a very long time. I have socks older
than that. Oh yes, sometimes I wear socks.

PCLinuxOS. Has kind of a ring to it. I am proud to be
a user of this OS.

Now, when I am asked how I handle a Windows
problem? Oh, I say, that is an easy fix. My answer is:
I USE PCLinuxOS. !!!!!!!!!!!!!!!!

May you live long and prosper!

HAPPY BIRTHDAY PCLinuxOS !!!!
– joechimp

Happy 10th Birthday, PCLinuxOS!

PCLinuxOS Magazine Mailing List:
http://groups.google.com/group/pclinuxos­magazine

PCLinuxOS Magazine Web Site:
http://pclosmag.com/

PCLinuxOS Magazine Forums:
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by Meemaw

I hope you are finding a few tricks to make your work
easier! In this installment of our series, we will look
at a few tricks in LibreOffice Impress.

Master Pages

As you know, when you open LO Impress, you are
met with basically a “blank canvas” which includes
one page. You have to add the pages, and design
them to your liking. The designs include the
background you can use and also the layout of each
slide. The Slides area on the left shows each of the
slides you have added. If you have designed a slide
already, you will see a thumbnail of it at left. If not,
the thumbnail will be blank. Many Master Pages
(backgrounds) and layouts exist for your use, and
more backgrounds can be downloaded from the
LibreOffice Extensions site. You can also design
your own backgrounds and layouts. If you have a
graphic you want to use, simply insert it on a blank
sheet and save that sheet as a template, that is,
click File > Save As Template...., and give it an
appropriate name. I used the farm scene below for a
presentation I did. Don’t forget to copy it to your LO
config folder so it will show up in LOImpress next
time you open it. In my Xfce install, it is
~/.config/libreoffice/4/user/template/Presentation
Backgrounds/ although all the templates are
installed to
/opt/libreoffice4.1/share/template/common/layout
/ so you could copy it to either place. A better
alternative is to import it into LOImpress from
wherever you saved it. In fact, my farm scene didn’t
show up until after I imported it into the templates by
clicking File > New > Templates, clicking the Import
button and choosing my new creation.

Most of the time you will choose a background
(Master Page) and put it on every slide in order to
make your presentation look uniform. Some
presentations need something different. It IS
possible to choose a background for each slide.
When choosing the background, you can right­click
on it and choose “Apply to All Slides” or “Apply to
Selected Slides”, as you wish. If I did that, I would at
least choose similar backgrounds rather than one
red, one green and one blue as I have above. One
idea I might suggest is to use a pre­made
background for the title page, and a simplified
version of the same one for the following pages.
That way you would have some variety, but
everything would be more uniform.

Hide a Slide

Suppose you create a presentation for two different
groups, but it contains financial information that one
group doesn’t need to see. Rather than creating one
presentation, removing the financial information and
re­saving it as a second presentation, you can hide

the slides that the second group doesn’t need.
Simply click on a slide in the slides list at left, and
choose Hide Slide. The slide will look the same in
your center workspace, but will have a shaded
rectangle over it in your Slides list. when you run
your slideshow, LOImpress will skip over hidden
slides. When you no longer want a slide hidden,
click on it again and choose Show Slide.

Reorder Pages

OK, you are really busy creating a multi­page
document, and you discover you have a page in the
wrong spot. This is actually an easy fix! You can
drag a page to a new location in the document.
Using your Normal workspace, you can click on a
slide in the Slides area at left, and drag it up or down
to the new location. You can also click on the Slide
Sorter tab above your workspace. There you will
have an arrangement of all your slides, in rows, left
to right. You can click on the slide you want to move
and drag it over to the correct position. In the
example below, I have dragged the 4th slide from
the top row, right side, down to the end after the red
slide (next page, top right).

LibreOffice Tips & Tricks, Part 4
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Save Presentation as a PDF

Just as with LOWriter and LOCalc, an LOImpress
file can be exported as a pdf. This is good if you
want to give your presentation to your audience for
reference after you are finished. Simply click File >
Export as PDF or click on the PDF tool in the
toolbar. You will see a window asking where to save
your document and what it should be named. Your
presentation file name is there by default, but you
can change the file name.

Oh, by the way, you can also print other forms of this
presentation. When you choose File > Print, you will
see a print dialog window that defaults to printing
each slide as they are in the presentation, but you
also see a drop­down that will have choices in it. You
can print the slides, outline, notes or handout. The
Handouts format puts six slides on a page and
prints them that way. Notice that the layout shown
for the handout only has four slides. One of them is
hidden, remember?

The Notes format puts one slide at the top of a page
and leaves space for the notes below. These are the
notes you may have added in your workspace tab
called Notes, and you can print these pages as a
presentation aid.

Slide Transitions

LOImpress has many transitions you can use. You
can change from one slide to the next by “wiping”
the screen from any of four directions, have it fade
out and the new slide fade in, have the slide change
to a changing checkerboard pattern and even have
a circular sweep of the page. Be sure to go in and
experiment. Some people will want to use a
separate transition for each slide. It can be done,
choosing the transition and clicking the button which
says Apply to Selected Slide… However, to bring
unity to your presentation, you probably should only
use, at most, two or three transitions. The
presentation I make for work every year only uses
one, and that’s sufficient for my audience.

Auto­play

If your presentation has sections that prompt
question and discussion, you should probably

advance the slides by hand. My yearly presentation
is a basic showing of events my company has
sponsored or participated in, so I can set the
presentation to run without anyone monitoring it. In
that case, you can set it on auto­play, and set a
certain time limit for each slide to show. Most of my
slides can be viewed in about 10 seconds, having
mostly photos, but I have one slide that is mostly
text, so I set the 10 seconds the entire presentation
by clicking Apply to All Slides…, but then go back
to that one slide and set a longer time on it, then
click Apply to Selected Slide…. That way the one
slide stays on the screen longer and can be read.

Impressive Bullets / Numbering

Many times the reasons we do a presentation is
because we have loads of information for our
audience. Many times, bulleted lists display that
information in a neat and orderly fashion. But,
really… do we HAVE to use those black dots all the
time? The answer, of course, is NO. LOImpress has
a big variety of bullet styles, so your presentation will
look different from that other guy’s. From Format >
Bullets and Numbering, you can click on the
Graphics tab and choose from many different
designs.

LibreOffice Tips & Tricks, Part 4
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Vary Your Content

Remember that you can put multiple types of media
on a slide ­ pictures, tables, sounds, graphs ­ not
just text. This will help to make your presentation
more informative, and probably less boring!
Remember not to make every slide that “busy” so as
not to overwhelm your audience. Also remember
that LibreOffice has a Gallery of clipart, just in case
you need one more little touch. It’s always available
from the toolbar (in Impress it’s in the bottom
toolbar) or from the menu in Tools > Gallery.

You can also insert a comment. This might help
if you have to pull up a presentation you haven’t
seen for a while. I inserted a comment into this
presentation. While you are typing it, there is a big
square over your slide (like a sticky note). When you
are finished and go on, it changes to a very small
square in the upper left corner of the slide you
added it to. Clicking the square opens your
comment. Don’t worry… it doesn’t show during the
slideshow.

Slide Presenter Console

This used to be an extension for LOImpress, but
they have incorporated it into the base program now.

It is only for those times when you have a second
display connected. In fact, it doesn’t show up in the
menu at all. The documentation says that it shows
up when the second display is connected. It allows
you to view the slideshow along with your slide
notes, plus the ability to see the upcoming slide and
control the presentation timer while the audience is
looking at the current slide. I haven’t had a chance
to experiment with this yet.

Summary

We have learned about some aids that help us use
LOImpress more effectively. I have learned several
new things myself! Next year’s presentation will be
even better! Next month we’ll look at LODraw.

1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

LibreOffice Tips & Tricks, Part 4
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by Paul Arnote (parnote)

Last month, I shared a script with you that downloads a new HD wallpaper from
National Geographic. You can run it as often as you like – daily if you want. I
modified the original script to allow you to only download the images, or to set the
newly downloaded image as the wallpaper for your current desktop environment.

This month, I’m sharing another script that downloads a new HD wallpaper from
Bing. Say WHAT?! Bing? That search engine run by the “evil empire,” Microsoft?!
Why yes, the one and very same.

Regardless of what you think/feel about Microsoft, one thing that they do have is
a new, high quality background image on their search page every single day. The
images are typically high resolution, and make for some excellent wallpaper
images. Since this script allows you to download them, you, me and everyone
else might as well get something for free from Microsoft. For myself, and probably
a lot of other users, therein lies the “sweet spot” of this script.

Compare the screenshot of Firefox displaying the Bing search engine, with the
image obtained with the Bing wallpaper script, then used as my wallpaper.

Get A New HD Wallpaper From Bing Every Day

http://pclosmag.com/html/Issues/201309/page01.html
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This was the background image on August 28, 2013 (when I started writing this
article), commemorating the 50th anniversary of the civil rights March on
Washington, D.C., in 1963. All of the downloaded images are 1366x768 in
dimension.

The script

Here is the script, in it’s entirety. You can type it into a plain text editor (Kate,
Kwrite, Mousepad, Leafpad, Geany, etc.), or copy and paste it from this article
into a plain text editor. If you’d rather save yourself the trouble, you can download
this script from the magazine’s website. Be sure to remove the “.txt” file
extension, save it to a location in your path, and make sure the file is marked as
being executable. The easiest way to do the latter is to open a terminal session
and type chmod +x path/to/script/bing.sh (provided you saved it as bing.sh).

#!/usr/bin/env bash

# ********************************
# *** FUNCTIONS
# ********************************

function make_js {
js=$(mktemp)
cat > $js <<_EOF
var wallpaper = "$PICTURE_DIR/$filename";
var activity = activities()[0];
activity.currentConfigGroup = new Array("Wallpaper", "image");
activity.writeConfig("wallpaper", wallpaper);
activity.writeConfig("userswallpaper", wallpaper);
activity.reloadConfig();

_EOF
}
function kde_wallpaper {
make_js
qdbus org.kde.plasma­desktop /MainApplication

loadScriptInInteractiveConsole $js > /dev/null
# sleep 2
xdotool search ­­name "Desktop Shell Scripting Console – Plasma Desktop

Shell" windowactivate key ctrl+e key ctrl+w
rm ­f "$js"
dbus­send ­­dest=org.kde.plasma­desktop /MainApplication org.kde.plasma­

desktop.reparseConfiguration
dbus­send ­­dest=org.freedesktop.DBus /org/freedesktop/DBus

org.freedesktop.DBus.ReloadConfig
dbus­send ­­dest=org.kde.kwin /KWin org.kde.KWin.reloadConfig
# kbuildsycoca4 2>/dev/null && kquitapp plasma­desktop 2>/dev/null ;

kstart plasma­desktop > /dev/null 2>&1
}
function xfce_wallpaper {
xfconf­query ­c xfce4­desktop ­p /backdrop/screen0/monitor0/image­path

­s $PICTURE_DIR/$filename

}
function lxde_wallpaper {
pcmanfm ­w "$PICTURE_DIR/$filename"

}
function mate_wallpaper {
gsettings set org.mate.background picture­filename

$PICTURE_DIR/$filename
}
function e17_wallpaper {
OUTPUT_DIR=~/.e/e/backgrounds
FileName=$PICTURE_DIR/$filename
edcFile=~/tmp/Bing.edc
echo 'images { image: "'$FileName'" LOSSY 90; }' > $edcFile
echo 'collections {' >> $edcFile
echo 'group { name: "e/desktop/background";' >> $edcFile
echo 'data { item: "style" "4"; }' >> $edcFile
echo 'data.item: "noanimation" "1";' >> $edcFile
echo 'max: 990 742;' >> $edcFile
echo 'parts {' >> $edcFile
echo 'part { name: "bg"; mouse_events: 0;' >> $edcFile
echo 'description { state: "default" 0.0;' >> $edcFile
echo 'aspect: 1.334231806 1.334231806; aspect_preference: NONE;' >>

$edcFile
echo 'image { normal: "'$FileName'"; scale_hint: STATIC; }' >> $edcFile
echo '} } } } }' >> $edcFile
edje_cc ­nothreads ~/tmp/Bing.edc ­o $OUTPUT_DIR/Bing.edj
sleep 2 && rm ­f ~/tmp/Bing.edc
echo 'Enlightenment e17 Bing.edj file created'
enlightenment_remote ­desktop­bg­del 0 0 ­1 ­1
enlightenment_remote ­desktop­bg­add 0 0 ­1 ­1 $OUTPUT_DIR/Bing.edj;

}
function usage {
printf "%s\n%s\n\n%s\n%s\n\n%s\n\n%s" \
"Bing will download the Bing Wallpaper Of The Day,"\
"and (optionally) set that picture as the new wallpaper."\
"Based on original script by thejandroman, and expanded by Paul Arnote

for PCLinuxOS."\
"Originally published in The PCLinuxOS Magazine (http://pclosmag.com),

Oct. 2013 issue."\
"Works for KDE4, Xfce, LXDE, Mate and e17 desktops."\
"Usage: $0 [arguments]"\
printf "\n %s\t%s" \
"­h, ­­help" "This help text"
printf "\n %s\t\t%s" \
"­d" "Download pictures ONLY"
printf "\n %s\t\tSetup for the %s" \
"­­xfce" "XFCE4 Desktop"\
"­­mate" "Mate Desktop"\
"­­lxde" "LXDE Desktop"\
"­­kde4" "KDE4 Desktop"\
"­­e17" "Enlightenment Desktop"
printf "\n"

}
# ********************************
# *** MAIN
# ********************************

Get A New HD Wallpaper From Bing Every Day

http://pclosmag.com/Misc-Downloads/bing.sh.txt
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if [ "$1" == "­­help" ] || [ "$1" == "­h" ] || [ "$1" == "" ]; then
usage
exit

fi

echo "===================="
echo "== Bing Wallpaper =="
echo "===================="

PICTURE_DIR=~/Wallpaper/Bing/

mkdir ­p $PICTURE_DIR

sleep 1

urls=( $(curl ­s http://www.bing.com|grep ­Eo "url:'.*?'"|sed ­e
"s/url:'\([^']*\)'.*/http:\/\/bing.com\1/"|sed ­e "s/\\\//g") )

for p in ${urls[@]}; do
filename=$(echo $p|sed ­e "s/.*\/\(.*\)/\1/")

if [ ! ­f $PICTURE_DIR/$filename ]; then
echo "Downloading: $filename ..."

curl ­Lo "$PICTURE_DIR/$filename" $p
else

echo "Skipping: $filename ..."
fi

done
if [ "$1" != "­d" ]; then

echo "Setting image as wallpaper"
fi
# For Xfce
if [ "$1" == "­­xfce" ]; then

xfce_wallpaper
fi
# For LXDE
if [ "$1" == "­­lxde" ]; then

lxde_wallpaper
fi
# For Mate
if [ "$1" == "­­mate" ]; then

mate_wallpaper
fi
# For KDE4
if [ "$1" == "­­kde4" ]; then

kde_wallpaper
fi
# For e17
if [ "$1" == "­­e17" ]; then

e17_wallpaper
fi

Modifications

To make this work for all of the mainstream desktops offered for PCLinuxOS, I
borrowed the functions from the NatGeo script to automatically set the wallpaper
for your chosen desktop environment. So, the script works exactly the same way
as the NatGeo script from last month. Instead of repeating all of the same
information here, I’ll refer you to the discussion in last month’s magazine article,
particularly the “Notes About The Desktops” section. Since I had already done the
“heavy work” by creating the functions to set the wallpaper for each desktop
environment in the NatGeo script, it only made sense to reuse that code.

However, it is important to reiterate two items. First, e17 users must enable DBus
Extensions module, or the script will not be able to change/set the desktop
wallpaper. Second, KDE4 users will need to install xdotool from Synaptic in
order for the script to set the desktop wallpaper. Users of Xfce, Mate and LXDE
don’t need to do anything special, except to run the script. Please refer to the
NatGeo article (previous link) and review the other notes.

Usage

The usage of the script is identical to the usage rules for the NatGeo script. Why
reinvent the wheel? When you find something that works and works well, you
might as well stick with it. Right?

$ bing.sh
Bing will download the Bing Wallpaper Of The Day,
and (optionally) set that picture as the new wallpaper.

Based on original script by thejandroman, and expanded by Paul Arnote for
PCLinuxOS.
Originally published in The PCLinuxOS Magazine (http://pclosmag.com), Oct.
2013 issue.

Works for KDE4, Xfce, LXDE, Mate and e17 desktops.

Usage: /home/parnote­t42/Scripts/bing.sh [arguments]
­h, ­­help This help text
­d Download pictures ONLY
­­xfce Setup for the XFCE4 Desktop
­­mate Setup for the Mate Desktop
­­lxde Setup for the LXDE Desktop
­­kde4 Setup for the KDE4 Desktop
­­e17 Setup for the Enlightenment Desktop

If you type either bing.sh, bing.sh ­h or bing.sh ­­help in a terminal session,
you will get the text above displayed in the terminal screen. If you type bing.sh
­d, the wallpapers will be downloaded to your computer, but it will skip setting the

Get A New HD Wallpaper From Bing Every Day
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image as your wallpaper. To download the image of the day and set that new
image as your desktop wallpaper, supply the appropriate command line option for
your selected desktop (­­xfce for the Xfce desktop, ­­mate for the Mate desktop,
­­lxde for the LXDE desktop, ­­kde4 for the KDE4 desktop, and ­­e17 for the
Enlightenment e17 desktop). There is virtually no error checking to insure that
you enter the right command, just to keep the script size small.

When you run the script, you will see the following displayed in the terminal
window:

$ bing.sh ­­xfce
====================
== Bing Wallpaper ==
====================
Downloading: MarchonWA_EN­US13404932946_1366x768.jpg ...
% Total % Received % Xferd Average Speed Time Time

Time Current
Dload Upload Total Spent

Left Speed
0 0 0 0 0 0 0 0

­­:­­:­­ ­­:­­:­­ ­­:­­:­­ 0
100 119k 100 119k 0 0 195k 0 ­­:­­:­­ ­­:­­:­­
­­:­­:­­ 955k
Setting image as wallpaper

The script will inform you that it is downloading a new image, and then setting it
as your desktop wallpaper.

$ bing.sh ­­xfce
====================
== Bing Wallpaper ==
====================
Skipping: MarchonWA_EN­US13404932946_1366x768.jpg ...
Setting image as wallpaper

If you’ve already downloaded the Bing “image of the day,” the bing.sh script will
skip downloading it again, but still set that image as your desktop wallpaper. This
makes it easy to switch back to the Bing wallpaper image of the day if you’ve
previously downloaded it and then changed your wallpaper to something else.
Just rerun the bing.sh script.

Summary

Between the NatGeo and Bing wallpaper scripts, no PCLinuxOS user should ever
worry about having or finding wallpaper image files. Both scripts retrieve very
high quality images that make perfect wallpaper images for any computer user’s
desktop.

Full Monty ...

Everything you might want or need –
plus the kitchen sink!

Get A New HD Wallpaper From Bing Every Day
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by Bald Brick

I don't like talking about myself. I find it pretentious.
Nevertheless:

I am seventy years old and live by myself in a small
flat in a suburb of Helsingfors, a.k.a. Helsinki. (Our
capital city has two official names: the original
Swedish one, and the Finnish one that is used by
the majority of my countrymen. Historically, Helsinki
is a pidginization of the Swedish name for the
surrounding countryside.)

This is where I live:

This is the view from my drawing room window
(center, top):

And this is the view from my balcony (bottom, right):

My kitchen is all too small, but I do have a sauna. I
sometimes miss the garden I used to have, but at
least I'm close to two manifestations of water. The
idea of living further from the sea is somewhat
strange to me.

I also miss my cats and dogs, but my back is so bad
that I couldn't possibly take a dog for long walks
several times a day, and I have gradually developed
an allergy that could kill me if I shared an apartment
with a cat. Asthma is not something to wish for.

I went to the same school as Linus Torvalds, but
thirty years before him, which actually means that it
wasn't the same school: its name is still the same
but after my time there, they have let in girls and
simplified the curriculum.

That girls were let in is probably a good thing even
(even if it's said that girls and boys don't mature at
the same pace), but in my day, we could choose
whether we wanted to concentrate on mathematics,
classical languages or modern languages. Today the
classical languages aren't an option any more, and
this is simply shameful. I actually picked math, but
the choice was mine.

Then, over fifty years ago I studied English and
Nordic Philology at the university, but over time I

became more and more active within the student
theatre and ended up as a script editor and theatre
director. I've also done some acting ­ and a bit of
teaching at the Theatre Academy ­ apart from giving
elocution classes at three universities. For the last
23 years before I retired, I was head of Radio Drama
at the Swedish section of our national broadcasting
company.

I have translated a couple of hundred plays from six
languages, and one of my own plays won the Prix
Italia some twenty years ago.

Since a very early age, my main hobby has been
cooking, but I actually find most things in life
interesting ­ except for athletics. (The reason I've
never been interested in sports ­ with the exception
of chess ­ is probably that I was a couple of years
younger than most of my classmates, and
consequently, never could compete.)

Even if I went to
the same school as
Linus Torvalds, I've
never met him. But
I do like to brag
about being his
grandfather's IT
teacher.

"You like
computers, don't
you?" asked one of
my colleagues.

"Why, yes", said I.

So he informed me
that he and I would
be the instructors

PCLinuxOS Family Member Spotlight:
Bald Brick
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at a one­day computer seminar organized for one of
our writers' unions. (We actually have three writers'
unions: one for those that write in Finnish, one for
those that write in Swedish, and one for playwrights
regardless of language.)

And the oldest one of the writers that turned up was
Ole Torvalds, who at the time ­ the mid eighties ­
was well known as a newspaper editor, a poet and a
translator. A few years later, he would be better
known as Linus Torvalds' paternal grandfather.

Now, my colleague and I mainly demonstrated word
processors and desktop publishing programs, but
my colleague also happened to mention the term
"operating system" a couple of times.

"Excuse me", said one of the writers. "What's this
operating system thing?"

So my colleague tried to explain it. After a couple of
minutes the eyes of all the writers were a bit glazed
over, and I had to step in:

"An operating system is the ghost in the machine."

"Ah", said the writers. "Of course."

Even if my father was the CEO of quite a large
company, I don't have any money. I'm poor as a
church mouse. When I finally got enough of
broadcasting, I retired a few years earlier than what
would have made economic sense. I suppose I
reacted a bit like my nephew when he was five and
got fed up with my sister.

He started packing all his toy cars.

Sister: "What on earth are you doing?"
Nephew: "I'm packing."
Sister: "But whatever for?"
Nephew: "I'm moving."
Sister: "Oh. May I ask you where? Or is it a secret?"
Nephew: "To Granny's of course."

Sister: "Of course. But she's at work at the library all
day."
Nephew: "Oh?"
Sister: "She really is."
Nephew (without hesitation): "I suppose it will have
to be some orphanage then."

He didn't really move. When I got fed up with
broadcasting, I did.

Of course, I'm handy with my hands. You give me
the right tools and the right materials and I'll build
you the Taj Mahal. Or something more modern. (But
not modernistic.)

I was born during an air raid, during which they
couldn't move my mother to an air raid shelter as
she was ... sort of ... giving birth. I don't remember
much of that though, even if my earliest memories
are a bit earlier than those of most people. I was two
when I had the most traumatic experience of my life,
and I may write about that in my memoirs but not
here.

And do you want me to explain why I started using
PCLinuxOS?

I first installed Slackware Linux in 1994, when I
could buy a set of CDs at a local book store. At that
time downloading it would have taken a week.
Shortly afterwards I switched to Red Hat ­ because
Red Hat became available at the same store ­ and
later I switched to Mandrake. Mandrake came with
KDE, while the default in Red Hat was Gnome. And
as Tex consistently had produced KDE RPMs that
were better than the "official" Mandrake ones, I
naturally tried out PCLinuxOS as soon as it became
available.

But I wasn't hooked yet. My main operating system
was OS/2 and that was all I needed.

Then my employer decided to standardize on
Windows 95. I had actually found Windows 3.x

almost useful ­ if you also installed PCTools for
Windows or Norton Desktop for Windows. But
Windows 95 as a company standard?

I told my bosses: this is an insult. I won't use it. And,
believe it or not, even at work I managed to get a
Linux computer instead, even if I wasn't allowed to
connect it to the company's network because of
security reasons. (How stupid can you get while
remaining alive?)

That's when I got rid of all Microsoft products.

PCLinuxOS Family Member Spotlight is an exclusive,
monthly column by smileeb, featuring PCLinuxOS forum
members. This column will allow “the rest of us” to get to
know our forum family members better, and will give
those featured an opportunity to share their PCLinuxOS
story with the rest of the world.

Are viruses,
adware, malware &
spyware slowing
you down?

Get your PC back
to good health
TODAY!

Get

Does your computer run slow?

Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!

PCLinuxOS Family Member Spotlight: Bald Brick
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Screenshot ShowcaseScreenshot Showcase

Support PCLinuxOS! Get Your Official

PCLinuxOS
Merchandise Today!

Where *BSD & Linux Converge

Posted by weirdwolf, September 7, 2013, running LXDE.
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http://forum.fossconvergence.org/index.php
http://www.dosgamesarchive.com/
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Ingredients:

9 lasagna noodles, uncooked
4 cups hot mashed potatoes
1/2 cup Herb & Garlic cream cheese spread
6 green onions, thinly sliced
1 cup Bacon Bits, divided
2 cups shredded Cheddar cheese, divided

Cooking Instructions:

1. Heat oven to 375°F.

2. Cook noodles as directed on package, omitting
salt. Meanwhile, combine mashed potatoes,
cream cheese spread, onions, 2/3 cup bacon and
1 cup Cheddar cheese.

3. Place 3 noodles in 13x9­inch baking dish
sprayed with cooking spray; cover with 1/3 of the
potato mixture. Repeat layers twice. Top with
remaining bacon and Cheddar; cover.

4. Bake 30 min. or until heated through. Uncover;
bake 3 to 5 min. or until cheese is lightly browned.
Let stand 10 min. before cutting to serve.

Options: For a change of pace, substitute cottage
cheese for the mashed potatoes.

Easy Pierogi Casserole

It's easier than E=mc2
It's elemental

It's light years ahead
It's a wise choice

It's Radically Simple
It's ...

PCLinuxOS Recipe Corner
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I'm on a campaign join my refrain

PCLOS will grow and expand

You'll never complain you it will sustain

Texstar always has the upper hand

I could sing Russian French German Polish or Greek

PCLOS is wonderful no matter what I speak

I've tried to entertain I'll say it again

PCLOS is the finest in the land

Please let me explain I want to make it plain

PCLOS is the best Linux brand

Everything to gain you're 'puter it will not strain

PCLOS is the finest in the land

I could sing Russian French German Polish or Greek

PCLOS is wonderful no matter what I speak

Texstar will always reign PCLOS will never wane

I hope I've made you understand

MP3 OGG

ms_meme's Nook: PCLOS Is The Finest In The Land

http://pclosmag.com/html/Issues/201310/files/pclosisthefinestintheland.mp3
http://pclosmag.com/html/Issues/201310/files/pclosisthefinestintheland.ogg
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by Paul Arnote (parnote)

Over the previous six months, I’ve been presenting a
series of articles that I’ve called “Xfce Power User
Tips, Tricks & Tweaks.” My plan was to wrap up the
series with this, the seventh article in the series, but
I’ve found another “power user” tip, which I’ll present
next month. I toyed with adding it to this article, but
decided that a tip this good needed its own article,
and it would make this article too long.

This month’s article is a collection of miscellaneous
tips, tricks and tweaks. Some of these were ones
that got inadvertently left out of previous
discussions. Some are ones I discovered after the
related article had already run. Others are ones that
didn’t fit into the other discussions, for one reason or
another.

Multi­Level Launchers

Like a lot of Linux users, I really hate my desktop
being littered with a lot of icons. Personally, it
reminds me of when I ran Windows, and every

program you installed wanted to place an icon on
your desktop – some of them whether you wanted
an icon there or not. Still, I do like to have easy and
quick access to some of my more frequently used
programs. This is where this Xfce tip comes in
handy.

Above is pictured a portion of my panel, showing my
grouping of launchers, along the top panel of my
screen. Take notice that four of the launchers show a
small downward pointing arrow at the left bottom
corner of the icon. The arrow serves as a visual cue
that there are other choices. My launcher for web
browsers is shown open above. Yes, I really do have
four web browsers installed. Here’s how to create a
multi­level launcher.

First, add a new launcher to your panel. The easiest
way to do this is to right click your mouse on the
panel you want to add the launcher to, then choose
Panel > Add New Items… from the context menu
that appears. Select “Launcher” from the dialog box,
then the “Add” button.

The new launcher will be placed at the far right edge
of the selected panel. Right click on the new
launcher, and select “Move” from the context menu.
Drag your mouse to where you want your new
launcher to appear. Then, right click on the new
launcher icon again, and select “Properties” from the
context menu.

Xfce Power User Tips,
Tricks & Tweaks: Miscellaneous
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Click on the “+” button along the right edge of the
dialog box.

A dialog box with all of your installed programs (that
use a GUI) will be displayed in a list. Find the
program you want to add to your launcher, and
select the “Add” button.

Once back to the Launcher properties dialog box,
click on the “+” icon again, and select the next
program you want to appear. Repeat this process for
every program you want to include in your multilevel
launcher. By default, the first program in the list of
launchers will dictate the icon used for your
multilevel launcher. Once you’re finished adding
programs to your multilevel launcher, select the
“Advanced” tab of the Launcher properties dialog
box.

Select the “Arrow button position” drop down list
box. It is labeled “Default” – by default. The default
value places the arrow position to the right of the
icon of the icon used to display your multilevel

launcher. I change this to “Inside Button” to reduce
the footprint of the launcher on my panel. This tells
Xfce to “paint” the arrow over the bottom left corner
of the icon on the panel.

Right above the drop down list box is another item,
called “Show last item used in panel.” If you check
this, the icon for your multilevel launcher will change
to depict the last item you used from the multilevel
launcher. I leave this unchecked. I prefer to have a
static icon displayed.

Now, here is a tip within a tip. You might have
noticed that I have separate icons for “regular”
Firefox, Chrome and Chromium, as well as the
private browsing option for each. The private
browsing option isn’t installed by default, and is
typically only available either from a menu inside
each browser, or via a command line switch. It’s the

latter that allows you to set up a launcher for starting
the browser in private browsing mode.

First, add in a duplicate icon for each of the
browsers that you want to enable a launcher for the
private browsing option. Double click on the
duplicate, which will bring up a dialog box similar to
the one above. In the example above, at the end of
the “Command” line add ­­incognito to the
command to launch Chromium (be sure to leave a
space between the %u and the command line
option). The same command line switch also works
for Google Chrome. For Firefox private browsing,
change the command to firefox ­private %u. Midori
comes with a private browsing option already set up,
so all you have to do is select it from the list of the
“Add New Item” dialog box when adding the
program to your multilevel launcher. Then, so you
can differentiate between the icons, change the
name to include “Private” and select “Save.”

Xfce Power User Tips, Tricks & Tweaks: Miscellaneous
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Auto Adjust Photos X 2

Back when we talked about working with Graphics
files, I gave you (the readers) the challenge of
making a Thunar Custom Action for correcting
photos with aaphoto (installable via Synaptic). I
covered using aaphoto in the October 2012 issue of
The PCLinuxOS Magazine.

When you install aaphoto, an entry is automatically
added to the “Open With…” context menu in Thunar.
However, that menu item only applies the default
values of aaphoto to the selected photos. A lot of
times, the default values work just fine. But by
creating your own custom action using aaphoto
gives you the opportunity to further customize what
aaphoto does to enhance your photos.

So why do I call this part of the article “Auto Adjust
Photos X 2?” Well, it’s because I have two slightly
different Thunar Custom Actions. They both basically
do the same thing, but each gives a slightly different

feedback to the user. One displays the output from
aaphoto in an informational text dialog box. The
other displays a pulsating progress bar while
aaphoto completes its task. To “mix things up” a bit,
the output display version uses Zenity to display the
dialog boxes on the screen, while the progress bar
version uses Yad.

Enter either “Auto Adjust Photo Colors (Output)” or
“Auto Adjust Photo Colors (Progress),” depending on
which one you prefer. If you prefer only one of the
custom actions, you can leave out the text in
parenthesis. Since I have both custom actions
defined on my Xfce installation, I use the text in
parenthesis to differentiate which one is which. Enter
“Automatically adjust colors in selected photos” as
the description.

Next, we need to enter the command to be executed
with the custom action. For the custom action that
displays the aaphoto output, the command to enter
is shown below. We are able to view the output by
piping the output from aaphoto (with the verbose
flag) to a Zenity informational text dialog.

D="$(zenity ­­title="Directory Name" ­­entry ­­
text="Please enter the directory name")"; if [ !
­d $D ]; then mkdir ­p $D; fi && Q="$(zenity ­­
title="Quality Level" ­­entry ­­text="Please
enter the quality level")" && aaphoto ­a ­o $D
­q$Q ­V %N | zenity ­­text­info ­­title="aaphoto
Progress" ­­width=300 ­­height=300

For the custom action that displays the progress bar,
here is the command to enter:

D="$(yad ­­title="Directory Name" ­­entry ­­
entry­label="Please enter the directory name")";
if [ ! ­d $D ]; then mkdir ­p $D; fi && Q="$(yad
­­title="Quality Level" ­­entry ­­entry­
label="Please enter the quality level")" &&
aaphoto ­a ­o $D ­q$Q %N | yad ­­progress ­­
pulsate ­­progress­text="Please wait ... images
being processed" ­­title="aaphoto Progress" ­­
auto­close ­­auto­kill

Xfce Power User Tips, Tricks & Tweaks: Miscellaneous
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Besides the difference of using Zenity and Yad,
there is one other difference. The progress bar
version turns off the verbose output from aaphoto,
by omitting the ­V command line switch. The
verbose output from aaphoto was proving to be
problematic, and causing the command to behave
inconsistently. Removal of the verbose output
command line switch seems to have eliminated the
problem.

You can just as easily add in commands and dialog
boxes to rotate the image and/or resize the images.
The aaphoto command line switch to resize images
is ­r or ­­resize, followed by either the percentage
(with the % sign) or the pixels of the long side of an
image. The resize command can only make images
smaller. To rotate images, aaphoto takes the
command line switches of ­­rotate90, ­­rotate180
and ­­rotate270. The ­­rotate90 switch is the same
as rotating an image 90 degrees to the right, or
clockwise. The ­­rotate270 switch is the same as
rotating an image 90 degrees to the left, or
counterclockwise.

So, let’s take a look at a couple of other incarnations
of the aaphoto command that you might find useful.

To rotate images:

D="$(zenity ­­title="Directory Name" ­­entry ­­
text="Please enter the directory name")"; if [ !
­d $D ]; then mkdir ­p $D; fi && Q="$(zenity ­­
title="Quality Level" ­­entry ­­text="Please
enter the quality level")" && R="$(zenity ­­
title="Rotation Degrees" ­­entry ­­text="Please
enter degrees rotation\n90 = Right, 270 =
Left")" && aaphoto ­a ­o $D ­q$Q ­­rotate$R ­V

%N | zenity ­­text­info ­­title="aaphoto
Progress" ­­width=300 ­­height=300

To resize images:

D="$(zenity ­­title="Directory Name" ­­entry ­­
text="Please enter the directory name")"; if [ !
­d $D ]; then mkdir ­p $D; fi && Q="$(zenity ­­
title="Quality Level" ­­entry ­­text="Please
enter the quality level")" && S="$(zenity ­­
title="Resize Pixels" ­­entry ­­text="Please
enter new size in pixels, based\non the long
edge of the image.\n\nYou may only reduce an
image.\nYou may not enlarge an image.")" &&
aaphoto ­a ­o $D ­q$Q ­r$S ­V %N | zenity ­­
text­info ­­title="aaphoto Progress" ­­width=300
­­height=300

As you can see, you can chain together Zenity entry
dialogs for many of the aaphoto command line
switch values. There is nothing to prevent you from
moving all of this to a custom bash script, either.
Doing so will give you easy access to every variable
for aaphoto, without having to repeat “code” in
multiple Thunar Custom Actions.

View JPEG Exif Information

The JPEG graphic format has something special
that separates it from other graphic formats. That
something special is the storage of all kinds of extra
information about the image. It is called Exif, which
is an abbreviation for Exchangeable image file
format. Here is the Exif information for one of the
National Geographic wallpapers that I’ve
downloaded:

File name : japanese­white­
eye_68766_990x742.jpg
File size : 673948 bytes
File date : 2013:07:22 23:40:37
Camera make : Canon
Camera model : Canon EOS REBEL T3i
Date/Time : 2012:10:24 08:19:42
Resolution : 990 x 742
Flash used : No
Focal length : 400.0mm (35mm equivalent:
3280mm)
CCD width : 4.39mm
Exposure time: 0.0025 s (1/400)

Aperture : f/5.6
ISO equiv. : 200
Whitebalance : Manual
Metering Mode: pattern
Exposure : Manual
Exposure Mode: Manual
======= IPTC data: =======
Record vers. : 2
Caption : The Japanese White­eye (Zosterops
japonicus), also known as the mejiro ( , ),
is a small passerine bird in the white­eye
family. The specific epithet is occasionally
written japonica, but this is incorrect due to
the gender of the genus. Its native range
includes much of east Asia, including Jap
Headline : Intense colors
Byline : Boris S.
DateCreated : 20121024
City : Tainan
State : Taiwan
Country : Taiwan
SuplementalCategories: Animals
SuplementalCategories: Nature
Keywords : bird
Keywords : japanesewhiteeye
Keywords taiwan

The JPEG Exif data is derived from the Exif data
used with TIFF image files. There is a 64 KB size
limit on the amount of Exif data that can be saved
within the JPEG file format. If you think about it, that
is a lot of data. The text of this article is less than 15
KB. You can read more about the Exif format here.
The Exif data displayed above from the National
Geographic wallpaper image is quite a bit more than
most images will contain.

Fortunately, it’s quite easy to make a Thunar Custom
Action to read and display the Exif information from
JPEG image files stored on your hard drive. This
Thunar Custom Action got inadvertently left out of
the discussion on working with graphic files, in the
March 2013 issue of The PCLinuxOS Magazine. To
do this, you will first need to install jhead from the
PCLinuxOS repository, via Synaptic.

Enter “View JPG Exif Info” in the “Name” field, and
“View the Exif info of the selected JPG file” in the
“Description” field. Then, enter the following in the
“Command” field:

Xfce Power User Tips, Tricks & Tweaks: Miscellaneous
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jhead %n | zenity ­­text­info ­­title="Exif
Info" ­­width=400 ­­height=250

Under the “Appearance Conditions” tab, enter
*.jpg,*.JPG as the file pattern, and place a
checkmark in front of “Image files” ONLY. Now, when

you right click on a JPG file, select “View JPG Exif
Info” from Thunar’s context menu. You should see
something similar to the dialog box shown above,
filled with the Exif information from the selected JPG
file. We can only view the Exif information for one file
at a time. If you want to view the Exif information for
multiple files, you will need to view them one at a
time.

Directory Playlist

This next Thunar Custom Action got inadvertently
left out of our discussion in the May 2013 issue
about working with multimedia files. This is what
happens sometimes due to my testing new Thunar
Custom Actions on more than one computer. I create
the custom action on one computer, move my work
to another computer, and forget to transfer the new
custom action to the second computer. Mea culpa.

Nonetheless, this Thunar Custom Action can take an
entire directory filled with your favorite music and
automatically create a *.m3u playlist file with the
same name as that directory. What’s great is that the
playlist is placed inside the directory that contains
the music files. You will need to install the unix2dos
command line utility, via Synaptic. This utility will
convert the text­based *.m3u playlist file from
Linux/Unix format, with a return character only at the
end of each line, to a DOS format, with a return and
carriage return character at the end of each line.
Unfortunately, some MP3 players may depend on
the *.m3u file being in the DOS format. Those that
don’t will most likely ignore it. So, we’ll include it, just
to be sure that we have maximum compatibility with
as many MP3 players as possible.

Enter “Directory Playlist” in the “Name” field, and
“Make a playlist from the files in a directory” in the
“Description” field. Then, enter the following in the
“Command” field:

ls ­w 1 ­R %n/ |egrep
*.'[fF][lL][aA][cC]|[aA][pP][eE]|[wW][vV]|[wW][a
A][vV]|[mM][pP][3]|[aA][aA][cC]|[oO][gG][gG]|[oO
][gG][aA]|[wW][mM][aA]|[mM][pP][cC]|[mM][4][aA]'
>%n/%n.m3u && unix2dos %n/%n.m3u

This command lists the contents of the selected
directory, and writes the filename of each audio file
(*.flac, *.ape, *.wv, *.wav, *.mp3, *.aac, *.ogg, *.oga,
*.wma, *.mpc and *.m4a) that it finds to the file with a
*.m3u file extension and the same name as the
directory. It then converts the file to DOS text file
format, with the unix2dos command.

For example, let’s suppose you have a directory full
of your favorite tunes from The Moody Blues, named
MoodyBlues. Right click on the directory and select
“Directory Playlist” from Thunar’s context menu.
Every audio file you have in that directory will be
written to a file named MoodyBlues.m3u, written
inside your MoodyBlues directory. That file is then
converted to a text file format that adheres to the
DOS specifications, with a CR + LF at the end of
each line.

Xfce Power User Tips, Tricks & Tweaks: Miscellaneous
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Here is an example of the *.m3u output from a folder
I have from a rip of Toby Keith’s Greatest Hits,
Volume 2 CD:

01_how_do_you_like_me_now.mp3
02_country_comes_to_town.mp3
03_you_shouldnt_kiss_me_like_this.mp3
04_im_just_talkin_about_tonight.mp3
05_i_wanna_talk_about_me.mp3
06_my_list.mp3
07_courtesy_of_the_red_white_and_blue_the_angry_
american.mp3
08_whos_your_daddy.mp3
09_beer_for_my_horses_duet_w_willie_nelson.mp3
10_stays_in_mexico.mp3
11_mockingbird_duet_with_krystal.mp3
12_go_with_her.mp3
13_you_aint_much_fun_live.mp3
14_shouldve_been_a_cowboy_live.mp3

Take note that if you have a subfolder that you don’t
want included (say that you converted all of your
MP3 files into OGG files, stored in a subfolder … I’ve
been known to do this very thing), this command is
recursive, which is just another way of saying that
it’ll list all the audio files it finds. You can either
remove the ­R command line switch from the ls
command, or you can manually edit the *.m3u file to
remove the duplicates.

Of course, this is very handy if, using our previous
example with The Moody Blues, you have each of
their albums in their own special subfolder. Each
subfolder will be read and the files it finds placed
into the MoodyBlues.m3u file into the order they are
listed/found.

Extract MP3 Audio From Video

This Thunar Custom Action makes it easy to
“extract” the audio from your favorite video files. This
is another “left behind” custom action, like the
Directory Playlist custom action above. The ability to
extract audio from a video can be an excellent way
to build your music collection. If you have a favorite
music video, you can download it from your favorite
video streaming site, then extract the audio from that

video. Or, if you have a favorite comedy show, you
can download the video and extract the audio from it
to playback on your MP3 player.

Enter “Extract MP3 Audio From Video” in the “Name”
field, and “Extract the audio track from the selected
video file” in the “Description” field. Next, enter the
following into the “Command” field:

ffmpeg ­i %f ­vn ­ar 44100 ­ac 2 ­ab 128 ­f mp3
%f.mp3 | yad ­­progress ­­percentage=40 ­­
progress­text="Please wait ... file being
processed" ­­title="Audio Extraction" ­­auto­
close ­­auto­kill

When you right click on a video file stored on your
hard drive, select “Extract MP3 Audio From Video”

from the Thunar context menu. You will see the
progress dialog box displayed above while the
Thunar Custom Action completes the task.
Depending on how big the video file is, it could take
a few minutes to complete the audio extraction.

Thunar’s “Send To” Menu

Thunar’s “Send To” menu has always been a huge
mystery to me. Very useful, but very mysterious. It
wasn’t until just recently that I’ve been able to figure
it out.

You will notice that there are several items already
populating the Send To menu. From the Send To
menu, you can create a link on your desktop, add
files to a data composition, or send an email
(provided you have your preferred email client setup
in Xfce Settings Manager > Preferred Applications).

Once you connect a removable drive – a USB hard
drive, a USB flash drive, or an SD card in a card
reader – it will also be listed among the choices. In
the image above, I simply inserted an empty 4 GB
SD card into the built­in card reader of one of my
laptops. It automatically appears as the second entry
in the Send To menu. The nice thing about using the
Send To menu to send items to a removable drive is
that you don’t have to mount it first. Thunar takes
care of automatically mounting the removable drive
when you send items to it.
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So far, not too much mystery. That comes in when
you try to figure out how to extend or customize the
Send To menu. Information isn’t nearly as plentiful
as it is for other aspects of Thunar. However, it’s
much easier than you might think.

For our exercise, we’ll add a Picasa Upload item to
Thunar’s Send To menu. First, you will need to
install googlecl from the PCLinuxOS repository.
You will also need to log into your Picasa account
and create an empty album, named “Uploads” (or
make it with the googlecl command from the
command line, like this: google picasa ­­create ­­title
“Uploads”).

You can later log into your Picasa account (via a
web browser) and move your uploaded images into
their own album. (Hint: open the “Uploads” album in
your favorite web browser, then select the
“Organize” button. Multi­select the images you want
to move, select the Move button, then provide the
name of the new album).

Next, we need to create a .desktop file in
~/.local/share/Thunar/sendto directory. If the
directory (directories) doesn’t (don’t) exist, create
them. Now, create the following picasa.desktop file
in that directory.

# picasa.desktop ­ Integrate picasa into
# the "Send To" menu.
#
# Requires the installation of googlecl
# and the prior creation of an album
# named "Uploads" (without quotes)
#
[Desktop Entry]
Type=Application
Version=1.0
Encoding=UTF­8
TryExec=google
Exec=google picasa post ­­title "Uploads" %F
Icon=picasa
Name=Picasa Upload
MimeType=image/jpeg;image/png

Because we added the MimeType entry into the
picasa.desktop file, the new addition to the Send To
menu will only appear for JPG or PNG files. If you
right click on any other file types, you will not see the
Picasa Upload item in the Send To menu. If you omit
the MimeType line, then the new Send To menu item
will be available for all file types.

One drawback to this particular Send To menu item
is that there is no visual feedback to know when the
task has been completed. This could easily be
remedied by creating a bash script that will also
display a Zenity progress dialog box, then calling
that script from the Exec= line of the picasa.desktop
file. The other thing you can do is add
StartupNotify=true as the last line in the
picasa.desktop file. That way, you’ll get the “busy”
cursor until the Picasa Upload task is completed.
However, that could be rather annoying if you are
wanting/trying to do other things while you wait for
the image uploads to complete.

Also, the additions to the Thunar Send To menu are
exclusive to each user. If you want multiple users to
have the same functionality on each of their user
accounts, you will need to repeat this entire process
for each user on the system (or copy the necessary
files to each user’s ~/.local/share/Thunar/sendto
directory).

Summary

One thing that makes Xfce so appealing to me is the
foresight of the Thunar development team to include
a relatively easy way to extend its functionality. For

me, Thunar is the epitome of what a file manager
should be, and exemplifies the Linux approach to
applications – do one thing, and do it well. It doesn’t
try to be all things to all users, but it does allow each
user to personalize their experience using Thunar. It
does this by extending that functionality with tasks
that aid that user’s particular tasks and needs.

I have to honestly say that my personal “wish list” for
Thunar is short; I can only think of two things I would
like to see implemented. One of those items is
something that we’ve already covered – the
accurate reporting of file sizes. But that one isn’t
going to happen any time soon, if at all. The other is
the ability to create submenu categories for the
Thunar Custom Actions. This ability would go a long
way in relieving the “clutter” for users who have a lot
of custom actions, and allow users to categorize and
organize their custom actions in logical groups.

Next month, I’ll present the last article in this series
(or at least, what I think is going to be the last). This
upcoming article will explore how to leverage and
tweak Xfce’s built­in desktop wallpaper slideshow.

Defending Your Rights

In The Digital World
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by Meemaw

This month we will make a silhouette of a tree using
Gimp, then next month we will put a sunset behind it
using Inkscape. I was sent this tutorial and it looked
really fun. You can use one of your own photos or
download one from a free site, making sure it is legal
to use it. I downloaded five from Google Images,
and then looked at them together to see which one I
wanted to use.

When you find the photo you want to use, open it in
Gimp. I think I want to use the one at bottom right.

Crop the photo down to only the tree. Yes, my Gimp
workspace has a grey background.

Now we will start adjusting the color, so click Colors
> Curves. You will get a graph with a diagonal line in
it. While watching your photo, adjust the color curve
(the diagonal line) so the color is disappearing. You
will have to grab it with your mouse and move the
line up and to the left.

There are several methods that will remove the
background but let’s use the Clone tool. Clone
everything you don’t want the same color as the sky
so you only see the tree. Notice that I have some
sunlight in the center of mine. I will want to clone
that as well.

Now that I’m finished cloning you can see what I
have left. I know it looks a little red, but we’ll fix that
soon.

GIMP Tutorial:
Tree Silhouette In Sunset, Part 1
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Now, click on Colors > Brightness­Contrast.
Change the Brightness and Contrast up by moving
the sliders to the right. Increasing the brightness
make the background lighter and increasing the
contrast will make the tree darker. Keep an eye on
your tree, though, because just sliding everything
clear to the right may cause you to lose the detail in
your tree. Mess with it a bit and discover the settings
that look best to you. Every photo is different too, so
my settings probably won’t work for your photo.

Click on Image > Mode and change it from RGB to
Greyscale.

Notice that part of my tree is grey and not black.
Now we will go back to Colors > Brightness­
Contrast and adjust again. This time we will adjust
the brightness down, and the contrast up. Make the
brightness ­100, and the contrast 110. There’s your
silhouette (center, top).

Sometimes we can sharpen our image just a bit.
Click on Filters > Enhance > Sharpen and see if it
helps, because sometimes it doesn’t. It didn’t make
any difference on mine.

Save your tree, and then export it as a picture file. I
usually use .png or .jpg.

Next month we will finish this project with Inkscape.

Screenshot ShowcaseScreenshot Showcase

GIMP Tutorial: Tree Silhouette In Sunset, Part 1

Posted by xredded, September 27, 2013, running KDE4.



PCLinuxOS Magazine Page 31

by Paul Arnote (parnote)

Believe it or not, this has nothing to do with the
popular genre of movies, television shows and
comic books. Nope. This isn’t about “The Walking
Dead,” one of the most popular shows on television.
And this certainly isn’t about the movies “World War
Z” or George Romero’s “Night Of The Living Dead.”

What we’re talking about are zombie processes.
Even with all that is good about Linux, it isn’t perfect.

No operating system is. No program is perfect.
Programs crash. Operating systems crash –
although in the Linux world, the latter is a relatively
rare occurrence. Especially when programs crash, or
when programs aren’t written properly, zombie
processes can be left behind.

Quite simply, the parent process either didn’t clean
up the child processes when it exited normally
(because of bad programming), or didn’t have the
chance to clean up the child processes when it
exited abnormally. As a result, a zombie process is

left behind. A zombie process cannot be scheduled
for further processing (the parent process that
spawned it has left it abandoned), but it cannot be
completely removed until it is determined that it is no
longer needed. Without its parent process, there’s
no way to determine if the remaining process is
needed. So, it’s just left hanging out there,
abandoned, and occupying a process ID that cannot
be reused until it has been released.

It’s by way of the process table that Linux is able to
keep track of everything that is going on all at once.
So, when you have a web browser, a word
processor, a terminal window, and a graphics viewer
running all at the same time that you’re listening to
music, plus all of the activity going on in the
background that most of us don’t see or even think
about, Linux keeps track of it all by way of the
process table.

When a child process exits, it sends a SIGCHILD
signal to the parent to let the parent process know
that one of its child processes has completed. When
this happens, the parent process should call the
wait() system call, which in turn will provide the
parent process with the exit status of the child, which
will then cause the child process to be removed from
the process table.

You can see if you have any zombie processes on
your system by issuing the top command in a
terminal session, then looking at the second line
down, all the way to the right. In the screenshot
above, I have no zombie processes. If you have a
LOT of zombie processes, it would probably be best
to either kill the associated parent process, or simply
restart a service (for those zombie processes that
are associated with a service).

How To Kill A Zombie
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To remove any zombie processes that you may have
on your system, you first have to get the process ID
numbers (the far left column of numbers in the
screenshot) of those zombie processes. There is a
better way to get the process ID numbers of any
zombie processes on your system. Open a terminal
session and enter the following on the command
line:

ps aux | awk '{ print $8 " " $2 }' | grep ­w Z

It will produce an output something like this:

Z 5802
Z 4771
Z 8629

Now, everyone knows you can’t kill a zombie. They
are already dead. Just kidding. To kill a zombie
(process), put a bullet in its head, like this:

kill ­9 5802

Actually, kill ­9 is not guaranteed to immediately
remove a zombie process. Sometimes that bullet
travels in “slow motion.”

When the parent process is terminated, the init
process (pid 1) adopts the zombie. init calls the
wait() function periodically to 'reap' the dead
processes resources. So, you may need to wait until
the next wait() call for your zombie processes to
meet the grim reaper.

Now you know the proper way to kill a zombie … er
… zombie process.

International Community
PCLinuxOS Sites

Netherlands

Turkey

Denmark

Czechoslovakia

Italy

Poland

Brazil

Linux Training
Courses & Classes

How To Kill A Zombie

http://www.pclinuxos.nl/
http://www.bekozap.com/
http://www.pclinuxos.dk/news.php
http://www.pclinuxos.cz/
http://pclinuxos.it/
http://pclinuxos.org.pl/
http://pclinuxos.fi/
http://www.pclinuxosbrasil.com.br/
http://www.linpc.us
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by Yankee

We all know the LXDE Desktop uses the OpenBox
Window Manager and has an lxpanel Menu which
handles the menu entries required for operation.
Here it will be shown how to add an LXDE
compatible menu to the OpenBox right click menu
and how to add some needed customizations to the
OpenBox menu. The first part will add the menu to
the system so it works by right­clicking on the
desktop, and in the second part, I’ll show how to add
customizations to the menu for your further use and
need. The whole process should take less than a
half hour, with just a few steps for each part.

Part One: Initial Setup

1) In the LXDE menu go to File Tools > Desktop
Prefs > Advanced and be sure the box is checked to
allow menus provided by Window Managers to
appear.

2) Go to Synaptic and install the openbox­menu
package.

3) In the file manager go to
/home/user/.config/openbox and rename the
menu.xml file to menu.xml.old. This will keep the old
file from being lost.

4) In the file manager in root mode, go to
/usr/share/openbox­menu and copy menu.xml­en to
/home/user/.config/openbox. Change the owner and
group in the file manager to your user and rename
the file to menu.xml for the English menu. A French
and German menu.xml is also there. Open the
menu.xml file in the Leafpad editor, and resave the
file as menu.xml.new. That will make a backup copy

of the new menu.xml. Close the editor.

5) In the LXDE menu, go to and open LXAutostart.
Enter the command below on the last line.

openbox­menu ­o menu.xml ­p ­g ­x ­t
"xterm ­e" applications.menu &

6) Logout or reboot, wait a few seconds, and right­
click on the desktop. The menu will appear as in the
below picture.

Here is a picture of the now working menu before
customization.

In this picture I’ve expanded the Preferences section
to show where a customization is needed.

Part Two: Customizations

1) Go to Synaptic and install obmenu.

2) Run obmenu from the LXDE menu run
command, or from a normal terminal.

3) Follow the steps illustrated in the pictures below,
of obmenu.

4) Logout or reboot, wait a few seconds, and right­
click on the desktop. The menu will appear as in the
last two pictures below.

Here we will add a “New Item” to the Preferences
section (highlighted) by clicking “New Item” on the
toolbar, then moving the item up or down using the
arrows on the right side of the toolbar. Add the
“Label” text and enter the “Execute” commands in
the lower box. This is for the LXDE Control Center.
Delete everything from “No effects” to “Xsnow off” by
highlighting them, then clicking on the minus icon on
the right side of the toolbar. Click Save.

LXDE 2013 With A Full Openbox Menu
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The new Terminal command needs to specify
lxterminal. Add another “New Item” where
highlighted, entering the necessary text in the
“Label” and “Execute” fields in the lower box for the
new Terminal command. Delete/remove the old
“Terminal” command (below that), the separator,
Sabayon command, and the Sulfur command by
highlighting them and selecting the minus icon on
the right side of the toolbar. Only delete those
commands. Click Save.

One more customization and we’re finished. Add
another “New Item” where highlighted above,
entering “Log Out” in the “Label” field, and “lxde­
logout” in the “Execute” field in the lower box. This is
for the LXDE logout GUI screen. Delete everything,
from “Log Out” to “Hibernation” by highlighting them
and clicking on the minus icon on the toolbar. Click
Save. Now, you’re done!

See the two past PCLinuxOS magazine articles
(below) if you are in anyway curious to further
expand or customize your OpenBox menu further.
They apply to OpenBox menu on LXDE also.

http://pclosmag.com/html/Issues/201108/page10.html

http://pclosmag.com/html/Issues/201110/page01.html

The two pictures below show what the final product
looks like in PCLinuxOS LXDE 2013.

The above picture shows the menu after
customizations, showing the LXDE Control Center
menu item that was added to the Preferences
section.

And here is another picture showing the menu fully
expanded.

Happy Birthday,
Neal!

We hope your health is improving,
and that you come back to the Forum soon.

We miss you!!

Visit Us On IRC
• Launch your favorite IRC Chat Client software

(xchat, pidgin, kopete, etc.)

• Go to freenode.net

• Type "/join #pclosmag"

(without the quotes)

LXDE 2013 With A Full Openbox Menu

http://www.fsf.org
http://pclosmag.com/html/Issues/201108/page10.html
http://pclosmag.com/html/Issues/201110/page01.html
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by YouCanToo

I have noticed lately all the talk about using XAMPP to install a web server on
your local computer. This has me wondering why one would choose to go outside
the normal repository to install XAMPP when we have a program that will do most
the same things with task­lamp. Not to mention that task­lamp is in the Synaptic
Repository.

Now for the warnings…… It is recommended not to install programs from outside the
official PCLinuxOS repositories. This can cause problems with your machine. You could
end up not being able to get support from the forum when you’re in need of support the
most!

To be fair in comparing XAMPP and task­lamp, I will install them on their own
hard drives.

The first thing I will do is start out by comparing the software that will be installed
by both XAMPP and task­lamp.

XAMPP Synaptic task­lamp

Apache 2.4.4 Apache 2.2.24­1 installed by task­lamp
MySQL 5.5.32 MySQL 5.1.55­2
PHP 5.4.19 PHP 5.3.25­1
PEAR PEAR not installed
Webmin ­ not installed Webmin 1.650­1 ­ not installed **
Python ­ not installed mod_Python 3.3.1­5 installed by task­lamp
SQLite 2.8.17/3.7.17 SQLite 3.717­1 ­ installed by task­lamp
multibyte (mbstring) support mbstring 5.3.25­1 ­ installed by task­lamp
Perl 5.16.3 Perl 5.10.1
ProFTPD 1.3.4c ProFTPD 1.3.4d ­ not installed **
phpMyAdmin 4.0.4 phpmyadmin 4.0.6­1 ­ installed by task­lamp
OpenSSL 1.0.1e OpenSSL 1.0.1d, 1.0.1e and 1.0.1j
GD 2.0.35 GD 2.0.35­5 ­ installed by task­lamp
Freetype2 2.4.8 Freetype2 2­2.0
libjpeg 8d libjpeg 6b

** Can be installed using Synaptic

XAMPP task­lamp

libpng 1.5.9 libpng 3.5.0
gdbm 1.8.3 gdbm 3.0.0
zlib 1.2.3 zlib ­ 1.2.8­2
expat 2.0.1 expat 1.6.0
Sablotron 1.0.3 ** Developer support has been dropped **
libxml 2.8.0 libxml 2.7.8
Ming 0.4.5 Ming 0.4.3­2 ­ not installed **
Webalizer 2.23­05 replaced by awffull 3.5.1­5 ­ not installed **
pdf class 0.11.7 pdf class ­ not installed
ncurses 5.9 ncurses 5.9­1
mod_perl 2.0.8 mod_perl 2.0.5­1
FreeTDS 0.91 FreeTDS 0.82­1 ­ not installed **
gettext 0.18.1.1 gettext 0.18.2
IMAP C­Client 2007e IMAP 2004g­4 ­ installed by task­lamp
OpenLDAP (client) 2.4.21 OpenLADP 2.4.33­1
mcrypt 2.5.8 php­mcrypt 5.325­1 ­ installed by task­lamp
mhash 0.9.9.9 mhash 2.0.1
eAccelerator 0.9.6.1 eAccelerator0.9.6.1­1 ­ installed by task­lamp
cURL 7.30.0 cURL 4.3.0
libxslt 1.1.28 libxslt 1.1.26
libapreq 2.12 libapreq ­ not installed
FPDF 1.7 libpdflib­lite 7.0.5­3 ­ not installed **
bzip 1.0.6 bzip2 1.0.6
ICU4C Library 4.8.1 ICU4C data Library 51.2­1
APR (1.4.6) APR 1.4.1­1 ­ not installed **
APR­utils (1.5.1) APR­utils 1.4.1­1 ­ not installed **

** Can be installed using Synaptic

I installed task­lamp to begin with.

Just what is task­lamp you ask ?

According to Synaptic it is a Metapackage for the Linux, Apache, MySQL, Proftp,
PHP and Perl serveX.

Installing A Web Server: XAMPP vs task-lamp
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This package is a meta­package, meaning that its purpose is to contain
dependencies for running LAMP­server, allowing easy installation of a
comprehensive LAMP testing/development setup. For a production server, you
may prefer to install a subset of the dependencies.

What does LAMP mean?

That depends on just who you ask, but one thing we can say for sure is it stands
for:

L ­ Linux it runs on our favorite operating System.
A ­ Apache, the workhorse of all web servers.
M ­ MySQL database
P ­ Perl and PHP ­­ some even say Python.

The first thing to do is open the Synaptic package manager, refresh it and then
check task­lamp for installation. It may take you sometime to install task­lamp
with its dependencies.

After installing task­lamp, I opened a console window as root and started the two
major services.

apache ­ mysqld, using the following commands:

service httpd start
service mysqld start

You should see something like this after entering each command.

Now opening my favorite web browser I entered the following URL
http://localhost

Yes, my web server is alive and answering http requests.

The next thing I want to do is check that phpmyadmin is working, and that the
MySQL database is accessible. So browse to http://localhost/phpmyadmin.

The normal password for phpmyadmin is:

username: root
password: blank

What’s this?

Now what are we going to do? We
have two options at this point. The first
is opening an editor as root and
changing the /etc/my.cnf file, or doing
the changes via the command line. I
am going to opt out for changing the
/etc/my.cnf file. I am going to be using
the nano editor.

In the console window as root I type in
the following command

nano /etc/my.cnf

Installing A Web Server: XAMPP vs task­lamp
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This magically opens the the my.cnf file. All I just have to find the variable called
“AllowNoPassword". The Ctrl + w key lets me search. I enter AllowNoPassword
and press return.

Now we want to change the highlighted line to read like this:

$cfg['Servers'][$i]['AllowNoPassword'] = true;

We want to change the variable from “false” to “true”. Now we need to save the
file so we press the Ctrl + x key and we are asked if we want to save the modified
buffer. Press Y. Now nano will display the name of the file to write to, just press

the Enter key. Nano will now save your file and close. While we are at the
console wind we want to make sure that php re­reads its configuration file. Enter
the following command:

service httpd restart

You should see something like this:

Installing A Web Server: XAMPP vs task­lamp
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[root@localhost phpmyadmin]# service httpd restart
Shutting down httpd: [ OK ]
Starting httpd: [ OK ]
[root@localhost phpmyadmin]#

Now lets go back to our web browser and try accessing phpmyadmin again:
http://localhost/phpmyadmin.

Enter root as the username and leave the password box empty and then press
go. If all works as planned we should see something like this.

If you made it this far, pat yourself on the back. We now have an operational web
server ­ mysql database server ­ with phpmyadmin.

Lets make sure that httpd (apache) and the MySQL database starts each time
you turn on your computer.

Open a console window as root, and enter the following commands:

chkconfig mysqld on
chkconfig httpd on

You will see something like the following images. Don’t be alarmed by the
warnings that will be displayed.

Installing A Web Server: XAMPP vs task­lamp
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Now every time that you boot your computer both the httpd service (web server)
and your MySQL database will be started. If you find you need or want a ftp
server, all you have to do is open Synaptic and choose which one you want to
use. The major ones are pure­ftpd ­ vsftpd and pro­ftpd. I have written recent
articles in the PCLinuxOS Magazine about installing and configuring each of
these ftp servers.

I do suggest that no matter which route you go to install your web server be it XAMMP or
task­lamp that you consider installing webmin to administrate your new web server. If
you use webmin with XAMMP you will have to change all the configuration paths for
each module in webmin to work, since XAMPP stores its files and configurations in non
standard places.

NOTE: running your database without a root password is very, very insecure.
Before doing anything else you should add a password to your MySQL database.
It only takes a few moments of your time and will save you a lot of headaches
down the road. NOTE: in the time it took you to read this NOTICE you could have
already changed your database password. I can not state this enough. PLEASE
ADD A PASSWORD to your database.

Configuration and log files paths

web server root directory /var/www/html
web server configuration /etc/httpd/conf/httpd.conf
mySQL configuration /etc/my.cnf
php configuration /etc/php.ini
phpMyAdmin configuration /etc/phpmyadmin/config.inc.php
web server log files /var/log/httpd

OK, so now, let’s have a look at XAMPP

What is XAMPP ?

X ­ means that the package can run under anyone of the following operating
systems:

* OS X
* Windows
* Solaris
* Linux

A ­ stands for Apache, Our workhorse web server.
M ­ stand for the MySQL database

P ­ stands for perl
P ­ stands for PHP

You can download the latest version of XAMPP from the apachefriends website.
Once you have downloaded and saved XAMPP file it is time to run and install it. I
have saved the XAMPP file to my ~/download directory.

I will open a console window as the root user and then change into my
Downloads folder. Since this is a installer script we need to give it permission to
execute (run). In the console window as root enter the following command:

chmod 755 xampp­linux­1.8.2­2­installer.run

Now we just need to execute the file (run it). Enter the command:

./xampp­linux­1.8.2­2­installer.run

That’s it. The program is now going to installing the required files.

Installing A Web Server: XAMPP vs task­lamp
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Now is the time for a coffee break, as this part takes a bit of time, until it is finally
complete.

Now we just click on finish and let’s see what we get. Well, not a lot, except the
window closes. It did have the Launch XAMPP box checked.

We will go the /opt/lampp directory and start it using the following command:

/opt/lampp/lampp start

Ahh, now this is better. Looks like things are up and running. Let’s open our
favorite web browser and go to http://localhost and see what happens.
Success!!!

A matter of security (A MUST READ!)

XAMPP is not meant for production use but only for developers in a development
environment. The way XAMPP is configured is to be open as possible and
allowing the developer anything he/she wants. For development environments,
this is great, but in a production or home environment, it could be fatal.

Here a list of missing security in XAMPP:

1. The MySQL administrator (root) has no password.
2. The MySQL daemon is accessible via network.
3. ProFTPD uses the password "lampp" for user "daemon".
4. PhpMyAdmin is accessible via network.
5. Examples are accessible via network.
6. MySQL is running under "mysql".
7. Apache is running under "daemon".

I have found that phpmyadmin has the same problem when it comes to entering
the roots password as a blank. This time you will need to edit the conf.inc.php
file, but from the /opt/lampp/etc/phpmyadmin folder to make the needed
corrections.

Configuration and log files paths

/opt/lampp/bin/ The XAMPP commands home.
/opt/lampp/bin/mysql calls, for example,
the MySQL monitor.

/opt/lampp/htdocs/ The Apache DocumentRoot directory.
/opt/lampp/etc/httpd.conf The Apache configuration file.
/opt/lampp/etc/my.cnf The MySQL configuration file.
/opt/lampp/etc/php.ini The PHP configuration file.
/opt/lampp/etc/proftpd.conf The ProFTPD configuration file.

(since 0.9.5)
/opt/lampp/phpmyadmin/config.inc.php The phpMyAdmin configuration file.

Please remember that the document folders and files are not in the standard
location when using XAMPP.

To stop XAMPP simply call this command:

/opt/lampp/lampp stop

You should now see:

Stopping LAMPP 1.8.2...
LAMPP: Stopping Apache...
LAMPP: Stopping MySQL...
LAMPP stopped.

And XAMPP for Linux is stopped. To remove XAMPP from your system simply
type in the following command:

Installing A Web Server: XAMPP vs task­lamp
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rm ­rf /opt/lampp

So how do I compare XAMPP to task­lamp ?

From a range of 0­5 with 5 being easy and 0 being
poor:

XAMPP task­lamp

Installation ease 4 4
Install time 4 4
Document/file locations 1 4
Security 1 4
Ease of removal 5 2

Screenshot ShowcaseScreenshot Showcase
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Installing A Web Server: XAMPP vs task­lamp

Posted by OnlyHuman, September 24, 2013, running e17.
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by Paul Arnote (parnote)

Google Chrome – the browser, not the OS – has wasted no time at all winning
over Internet users. Recent figures show that, despite coming to the party late,
Google Chrome has the largest market share for web browsers. It has surpassed
its competition – Firefox, Safari, Internet Explorer, Opera, etc. – in garnering the
largest usage among those browsing the web. All of this seemingly occurred
overnight (even though it didn’t), especially when you consider how long the
competition has been around.

Here are the figures for August, 2013:

Internet Explorer: 11.8%
Firefox: 28.2%
Chrome: 52.9%
Safari: 3.9%
Opera: 1.8%

There are a few things that has lead to the popularity of Google’s web browser.
Stability and speed top that list, along with a wide availability of popular plugins

that extend the browser’s functionality. Among that assortment of plugins is one
called “My Chrome Theme.”

My Chrome Theme allows the user to personalize their copy of Google Chrome,
and it even allows them to share that theme with other users. Just to be sure that
your customization handiwork isn’t lost, you can even download your completed
theme as a *.zip file.

One way to get to where you can install an additional extension into Google
Chrome is to select “Settings” from the Google Chrome menu, clicking on
“Extensions” on the left upper side of the screen, then going to the end of the list
and selecting the “Get More Extensions” link. The other way to install an
extension into Google Chrome is to simply open a new tab and display the
installed apps. On that screen select the “Store” icon, then search for “my chrome
theme” in the Chrome Web Store, and click on “My Chrome Theme” in the list.
However you get there, you should see something similar to the image above.

When you get the dialog box similar to the one above, click on the “Add” button.

Personalize Google Chrome
With My Chrome Theme
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In the next dialog box, specify where you want a shortcut to My Chrome Theme
installed. By “Applications menu,” it is referring to the “Apps” screen in Google
Chrome. Next, go to the “Apps” screen in Google Chrome. The easiest way to do
that is to open a new tab, and click on the Apps marker at the bottom of Google
Chrome’s “New Tab” tab. Click on the icon for My Chrome Theme.

First, you need to provide an image to use for the background of your “New Tab”
window. Most people will want to upload an image from their computer. You can
also do a capture from a webcam. Once you have selected your image, click on
the “Continue to Step 2” button at the upper right. This step is optional, believe it
or not.

You can opt to have a plain, solid color background instead. If the latter is your
choice (maybe you just want to colorize the tabs, tab background and main
window background), simply click on the “Continue to Step 2” button at the upper
right. Google Chrome will give you a “DOH!” message, informing you that you
haven’t selected an image, and asking you if you want to proceed. Simply tell
Google Chrome “Yes” to proceed.

If you selected an image, you will be given a chance to adjust the image position,
add image effects, or select a new image. The slider at the bottom allows you to
select between “design mode” and “preview mode.” All that preview mode does is
superimpose a representation of the apps that display on your Apps screen over
the top of the image, to give you an idea of what your image might look like
beneath the icons.

Personalize Google Chrome With My Chrome Theme
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Under “Step 2” of the process, you can select custom colors for the foreground
tab, the background tab, and the color of the window beneath the tabs. Simply
select the paintbrush icon above the corresponding part, then select the desired
color from the color palette that is displayed.

If you opted to not display a picture, a fourth paint brush icon will be displayed to
allow you the opportunity to set the main window background color. This step is
also optional, allowing you to set only an image and keep the default colors.
Once you have the theme colors set how you like (or if you are just keeping the
default colors), click on the “Continue to Step 3” button at the upper right side of
the screen.

The next screen gives you a preview of all of your choices. Give your new theme
a name. I called this theme BabyRyan. Then, click on the “Make my theme!”
button in the upper right corner of the window.

On the next screen (top of next column), click on the “Install My Theme” button.
Here, you can also share your theme with others, by clicking on the “Share
Theme” button. You can also start over by clicking on “Make A New Theme”
towards the bottom part of the window.

With my new theme, BabyRyan, created and installed, opening up a new tab in
Google Chrome displays as shown above.

Personalize Google Chrome With My Chrome Theme
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To manage your custom Google Chrome themes,
simply start the My Chrome Theme app and scroll to
the bottom of the screen. There, you will see
thumbnails of your created themes. Click on the
desired theme, and you will be given the chance to
install or share your theme. Hover your mouse over
the thumbnail, and you will notice an “X” in the upper
right corner of the thumbnail. Clicking on the “X” will
delete the custom theme. You can also click on the
“Find More Themes In The Chrome Store” below the
thumbnail display strip, and you can find and install
additional Google Chrome themes. There is no option
to edit a current theme. Instead, you will need to start
over and make a new theme.

On my computers, I typically have both Google
Chrome and the open source version, Chromium,
installed. I do this for a couple of different reasons that
I choose to not go into at this time. Sometimes, things I
do in one browser – either Chrome or Chromium – will
show up in the other. This is not the case with My
Chrome Theme. While My Chrome Theme works in
both versions of the browser, you will have to recreate
the theme in the “other” browser if you want it to
display in both.

Summary

My Chrome Theme takes personalization of a web
browser to a whole new level. Firefox may have
Personas, but My Chrome Theme makes it much
easier for the average user (even those who may not
be particularly “computer savvy”) to customize their
web browser experience.

Screenshot ShowcaseScreenshot Showcase
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Posted by Actarus5, September 3, 2013, running KDE4.
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by daiashi

About The Game

Forced is a one­ to four­player co­op arcade action
RPG with puzzle and tactical elements. You are cast
as slaves in the toughest fantasy gladiator school of
them all, condemned to fight as a gladiator and
eventually win your freedom. You will face deadly
trials and huge creatures, but Balfus, your Spirit
Mentor, will guide you in your quest for recognition.

System requirements:
Fully updated PCLinuxOS and Steam

Hardware:
Minimum:

OS: PCLinuxOS
Processor: 2.2 GHz Intel Core 2 Duo
Memory: 2 GB RAM
Graphics: DirectX 9.0c­compatible,

SM 3.0­compatible
Hard Drive: 5 GB available space

Recommended:
OS: PCLinuxOS
Processor: QuadCore 2.0 GHz +
Memory: 4 GB RAM
Graphics: Nvidia Geforce GT 120 /

ATI Radeon HD
Hard Drive: 5 GB available space

About The Company

BetaDwarf was formed by a small group of persons,
who moved into a classroom at a University in
Denmark. It took the University seven months before
a lecturer accidently walked into the room and
realized that eight guys actually lived in one of their
classrooms. So BetaDwarf was thrown out and the
group decided to move together into a big house,
where they made a successful kickstarter company,
and are now on their third year of development on
FORCED.

Some Gameplay Screenshots

Game Zone: Forced
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Getting It To Run

Install Steam (if you don’t have it installed already),
then start it. You will need to create a new account, if
you do not already have one. Once you have Steam
up and running, go to the store tab. Click on the
Linux tab if you wish and search for Forced. Click on
and download the demo. If you have updated your
system, including graphics drivers, you should be
good to go.

http://store.steampowered.com/app/96200/

Visit Us On IRC
• Launch your favorite IRC Chat Client software

(xchat, pidgin, kopete, etc.)

• Go to freenode.net

• Type "/join #pclosmag"

(without the quotes)

It's easier than E=mc2

It's elemental
It's light years ahead

It's a wise choice
It's Radically Simple

It's ...

linuxfordummies.org

There Are No Stupid Questions

Game Zone: Forced

http://www.pclinuxos.com
http://linuxfordummies.org/
http://store.steampowered.com/app/96200/
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by Paul Arnote (parnote)

With today’s modern desktops, using Linux has
never been easier. Linux is no longer the solitary
bastion of computer geekdom. The well thought out
and user friendly graphical user desktops available
for Linux insulate many users from the often
perceived difficulty of the Linux command line.
Running Linux is no more difficult than running any
of the commercially available operating systems.
Today, many Linux users can control their hardware
and favorite operating system without ever having to
touch or look at a command line prompt.

As a result, many Linux users don’t even bother to
learn how to operate or navigate Linux from the
Linux command line. To some of those users, just
opening a terminal session is wrought with anxiety,
fear and trepidation.

But what would you do if, all of a sudden, your
favorite graphical desktop stopped working
properly? Would you be able to “fix” your beloved
graphical desktop from the command line?
Unfortunately, for many Linux users, the answer to
this question is a resounding NO.

Disaster Hits Home

Let me use a personal account of something that
happened to me not all that long ago. Without some
prowess and ability to utilize every tool at my
disposal – including the command line in a terminal
session – I’m not sure that I’d have been able
restore my desktop to fully functional status, without
having to do a full reinstallation.

I don’t keep it any kind of huge secret that my
favorite desktop environment is Xfce. I have the Xfce
desktop installed on most of the computers in my
house (and that’s quite a few). But being the
magazine editor, I also have one computer that has
a “bare metal installation” of KDE. I also have full
installations of LXDE, Mate and e17 in VirtualBox.

One day in the not too distant past, I was updating
KDE on that particular computer. The update from
Synaptic seemed to go without a hitch. However, on
that particular day, for some reason, I didn’t
immediately restart the computer. Not too long after I
finished the update, plasma­desktop crashed. It
didn’t just crash. It crashed H­A­R­D. Please don’t
get me wrong – this is not an attempt to malign KDE.
It just happens to be that this problem occurred on
my KDE installation.

I originally thought it would be a simple logout then
log back in, and my desktop would be back just the
way I had it configured. Nope. That wasn’t to be.
When my KDE desktop reappeared, my wallpaper
was there, along with the YAWP desktop applet.
That was all. I knew other things were running. I was

getting notifications that Yakuake and my wireless
connection had started, and I was getting email
notifications of new emails from checkgmail, which I
also run.

However, I had no panel. Nada. Not even a sign or
hint of a panel. All of my panel launchers were gone.
Also gone was the PC menu, from where you can
typically launch all of your programs. No task area.
No notification area. Just a big empty spot (now
filled in with just the wallpaper) where my panel used
to be.

In my mind’s eye, I could easily imagine the horror
and panic a less experienced user might experience.
Trust me, even for as long as I’ve been using Linux
(including the command line), the situation caused a
fairly good sized lump to form in my throat. So now it
was time to put on my detective hat and figure out
what went wrong.

Right clicking on the desktop, I discovered that I still
had access to the context menus. First, I tried to
launch KDE’s “Configure Your Desktop” control
panel. My plan was to simply eliminate and then

A Lesson: Why It's Important
To Learn The Command Line
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rebuild my panel. But no, the control panel wouldn’t
launch. It complained about not being able to find a
library named icu18n. I searched through the
PCLinuxOS forum (on another nearby computer)
and discovered what package provided that
particular library.

I then returned to the computer that has KDE
installed on it. Since I received the notification that
Yakuake had successfully started, I tried the
keyboard shortcut that caused Yakuake to open (I
love having a Quake­style drop down terminal just a
keystroke away). Phew! Yakuake opened with a
familiar command line prompt. Because I had just
run updates from Synaptic, I knew (hoped?) that I
had an up­to­date package list. I also knew, thanks
to the notifications, that I also had wireless access.

Armed with the name of the package that contained
the missing library file, it was time to reinstall the
library from the command line. Also, knowing that
only the root user has the necessary privileges to
install stuff from the repository, I knew that I could do
this from the command line only if I performed this
task as the root user.

First, I entered su, followed by the root user’s
password on my system. Success! The command
line prompt changed to red. Next, I entered apt­get
install [package­name] at the root prompt in
Yakuake (substituting the name of the package that
contained the icu18n file for [package­name]). With
the package successfully installed, I restarted the
computer.

With bated breath, I eagerly awaited the resurrection
of my seriously ill KDE desktop. But no, it wasn’t to
be. It still appeared as it had before, still without a
panel. Drats! But now, I had a fully functioning KDE
Configure Your Desktop. There were no more
complaints of icu18n being AWOL.

Out of curiosity, I logged into KDE as the root user. I
wanted to see if the root user account still had a
panel. If it did, then I could safely deduce that the

problem was with a file in the /home directory of my
user account. Otherwise, it would indicate that there
was a problem with some of the core KDE files.
Tada! The root user account still had a panel.

Whenever a new user account is created, each user
account is created with the same configuration and
options. It is then up to the individual user to tailor
the appearance and configuration of their desktop.
Anyone who has been around for a while (and
paying attention) will/should know that those basic
user configurations are stored in /etc/skel. If you
didn’t know that, you do now.

From a previous issue I had on KDE, I knew the
location and name of the configuration file that
controls a lot of the plasma desktop applets on my
computer. The path and filename of that file is
~/.kde4/share/config/plasma­desktop­appletsrc.
It also happens to control my panel and the panel’s
notifications area.

I logged back into my normal user account. First, I
opened the file in a text editor, but couldn’t see
anything flagrantly wrong. So, instead of trying to
debug it (which could have taken hours), I renamed
the existing plasma­desktop­appletsrc file by
appending “.new” to the end of it. Since there was
already a backup file right next to it, I removed the
“.bak” extension on the file, the logged out and back
in. Sure enough, I had a panel back on my desktop.
But that backup copy was from the one that I had
problems with before. I then renamed that file to
have an “.old” file extension.

So, I logged back into the root user account, and
went to the default configuration files in /etc/skel. I
found the plasma­desktop­appletsrc file there, and
copied it to my normal user directory (in the path
listed above … the file has to be in the right place).

My KDE4 desktop, after resurrection.

Logging back out of the root user account, I logged
back into my normal user account. Lo’ and behold, I
now had a panel again on my desktop. Yay! All I had
left to do was to change my wallpaper from the
default wallpaper that was displayed, and restore my
YAWP plasma applet back to the desktop.

The Value Of The Command Line

In this instance, having some command line
knowledge – specifically, knowing how to reinstall
the missing icu18n library file with apt­get – was key
to resurrecting my KDE desktop. I also don't
underestimate the value of knowing something
about the configuration files for KDE. Without that
knowledge, my only solution would have been to
reinstall KDE.

So, where can you learn how to use the Linux
command line? The first place to look would be to
download The PCLinuxOS Magazine Command
Line Interface Intro Special Edition from the
magazine’s website. Pete Kelly, a.k.a. critter, created
an awesome 12­part introduction to the command
line interface that walks a user from the very basics
of command line use through more complicated
commands and topics.

A Lesson: Why It's Important To Learn The Command Line

http://www.linuxforum.com
http://pclosmag.com/download.php?f=CommandLineInterfaceSE.pdf
http://pclosmag.com/download.php?f=CommandLineInterfaceSE.pdf
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Another excellent source of information to learn the
Linux command line is The Linux Command Line, by
William E. Shotts, Jr. It’s a free download, released
under the Creative Commons­Attribution­
Noncommercial­No Derivatives 3.0 license. This 527
page PDF ebook starts from the very beginning and
walks you through all aspects of the Linux command
line.

Sometimes, you just need a quick memory jogger,
and that is where the Bash Cheat Sheet comes in
handy. This PDF document doesn’t provide any in
depth explanations. Rather, it just provides the
command with a very brief explanation.

Linux Fundamentals, by Paul Cobbaut, is another all
inclusive PDF ebook that will be useful for Linux
users of all experience levels. Everyone from the
newest Linux noob to the most hardened­in­the­
trenches veteran will find something useful within its
pages. This ebook was just updated in August 2013,
so the data is very up­to­date.

Introduction to Linux: A Hands on Guide, by Machtelt
Garrels is a 223 page PDF ebook that covers all
aspects of working with Linux, including some
command line usage. It is released by The Linux
Documentation Project, a.k.a. TLDP.

If you are interested in proceeding on to creating
your own bash scripts (it would be best to learn your
way around the basic command line first), then the
Advanced Bash Scripting Guide, by Mendel Cooper,
is the book for you. This 907 page PDF ebook
covers all things related to creating bash scripts. I
will personally attest to the value of this reference
book. When I’m writing a bash script, this tome is
never far away (and usually opened in a PDF reader
on another desktop).

There are many other references available on the
web. Just perform an internet search for them. If you
prefer your reference resource to be in PDF format,
just append “pdf” to your search criteria. These six

resources should keep you plenty busy and get you
off to a good start.

Summary

So, I was successful in resurrecting my KDE desktop
from the throes of death. Sure, I could have simply
reinstalled my KDE desktop from a current Live CD.
But then, I’d have to spend a considerable amount
of time tailoring KDE to how I like it to be, reinstalling
all the programs I use, and getting everything just

how I like them to be. Plus, if I re­installed KDE,
what would I have learned in the process? Nothing,
whatsoever. There’s also a feeling of
accomplishment when you’re able to resurrect a
seriously ill system.

While the Linux GUI desktops are very good and
typically very stable, you’ll do yourself a favor by
knowing how to navigate your system and the
command line. Fortunately, those skills may not be
needed very often, but are priceless when needed.

Screenshot ShowcaseScreenshot Showcase

A Lesson: Why It's Important To Learn The Command Line

Posted by coffeetime, September 12, 2013, running LXDE.

http://sourceforge.net/projects/linuxcommand/files/TLCL/13.07/TLCL-13.07.pdf/download
http://cli.learncodethehardway.org/bash_cheat_sheet.pdf
http://linux-training.be/files/books/LinuxFun.pdf
http://www.tldp.org/LDP/intro-linux/intro-linux.pdf
http://www.tldp.org/LDP/abs/abs-guide.pdf
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SUDOKU RULES: There is only one valid solution to each Sudoku
puzzle. The only way the puzzle can be considered solved
correctly is when all 81 boxes contain numbers and the other
Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled for
you. You cannot change these numbers in the course of the game.

Each column must contain all of the numbers 1 through 9 and no
two numbers in the same column of a Sudoku puzzle can be the
same. Each row must contain all of the numbers 1 through 9 and
no two numbers in the same row of a Sudoku puzzle can be the
same.

Each block must contain all of the numbers 1 through 9 and no two
numbers in the same block of a Sudoku puzzle can be the same.

SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non­English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters
in your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is
list of how they are scored:

0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to
12 minutes per letter tile set.
7. Have fun! It's only a game!

225 Possible, Average Score 158

PCLinuxOS Puzzled Partitions

Tux Scrappler
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http://pclosmag.com/html/Issues/201305/files/2013-05-PuzzleSolutions.pdf
http://pclosmag.com/html/Issues/201310/files/2013-10-PuzzleSolutions.pdf
http://www.scrabblepages.com/scrabble/rules/
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1. boat with large sail which can be raced

2. arctic transportation

3. 2­wheeled motorized vehicle

4. farmers use this to pull the planter
or mower

5. wealthy people travel on this

6. huge tourist boat

7. military combat vehicle

8. flies with rotors rather than wings

9. 2­wheeled vehicle which comes
in many sizes

10. long, narrow boat that must be paddled

11. farm implement that harvests grain

12. motorized camping trailer

13. long car which can hold many rich people

14. cleans & smooths the ice at the skating
rink

15. Mom's car, often

PCLinuxOS Puzzled Partitions

PCLinuxOS Crossword Puzzle: October 2013
Vehicles

Download Puzzle Solutions Here!

http://pclosmag.com/html/Issues/201305/files/2013-05-PuzzleSolutions.pdf
http://pclosmag.com/html/Issues/201310/files/2013-10-PuzzleSolutions.pdf
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airplane
all terrain vehicle
ambulance
automobile
battleship
bicycle
canoe
cruise ship
combine
dogsled
ferry
golf cart (shows as separate words)

helicopter
limousine
minivan
moped
motorboat
motorcycle
motorhome
sailboat
scooter
tank
tractor
train
truck
wagon
yacht
zamboni

PCLinuxOS Puzzled Partitions

Vehicle Word Find
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http://pclosmag.com/html/Issues/201305/files/2013-05-PuzzleSolutions.pdf
http://pclosmag.com/html/Issues/201310/files/2013-10-PuzzleSolutions.pdf
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More Screenshot Showcase

Above: Posted by Crow, September 16, 2013, running KDE4.
Below: Posted by RobNJ, September 12, 2013, running LXDE.

Above: Posted by kensum, September 2, 2013, running KDE4.
Below: Posted by nymira, September 4, 2013, running KDE4.




